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Chapter 1: System and Software 
Introduction 

Instrument Overview 

The MAGPIX® combines the fluidics subsystem, mechanical subsystem, an electronic subsystem, and an optical 

subsystem with magnetic microspheres and complex computer analysis to perform multiplex assays. 

The MAGPIX system operates by using magnetic beads (microspheres) that are coated with a reagent specific to 

a particular bioassay, enabling the capture and detection of specific analytes from a sample. The sample mixture 

is aspirated by the sample probe and conveyed via drive fluid into the camera chamber, where the microspheres 

are pulled down into a monolayer by the magnet, immobilized, and imaged. Within the chamber, microspheres 

are exposed to a red LED and a green LED, which excite both the internal dyes that identify each bead’s color 

signature and the reporter fluorescence from the surface of the microspheres. The red LED is responsible for 

classifying the microspheres. The CL1 and CL2 filters function to categorize the microspheres based on color 

signature and place them properly on the bead map as well as throw out any doublets that may exist. The green 

LED with the RP1 filter excites the reporter fluorescence, which identifies the quantity of analyte captured for each 

bead region. The microspheres are then flushed to the waste fluid bottle, clearing room for the next sample. 

 

 

Software Overview 

xPONENT® software analyzes images. The red-illuminated images classify the microspheres and the green-

illuminated images determine what elements of the sample have bonded to their surfaces. xPONENT reports the 

results to the user. 

The primary language of the user interface is English. xPONENT uses the host PC’s regional settings for 

displayed time, date, and numeric values. If you choose to export data in U.S. regionalization format only, you can 

change this setting on the Admin page > CSV Options tab and Admin page > Batch Options tab. Otherwise, data 

will be exported per your PC’s regional settings. 

 

 

Consumables Overview 

Luminex® xMAP® Technology requires two kinds of reagents: common laboratory reagents and reagents created 

only for Luminex instruments. 
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Luminex Technical Support 

Contact Luminex Technical Support by telephone in the U.S. and Canada by calling: 1-877-785-(2323) Contact 

outside the U.S. and Canada by calling: +1 512-381-4397 

International: + 800-2939-4959 

Fax: 512-219-5114 

Email: support@luminexcorp.com. 

Additional information is available on the Luminex website. Search on the desired topic, navigate through menus. 

Also, review the website’s FAQ section. Enter http://www.luminexcorp.com in your browser’s address field. 

This manual can be updated periodically. To ensure that you have a current version, contact Technical Support. 

 

 

Symbols Glossary 

You will encounter these symbols throughout this manual. They represent warnings, conditions, identifications, 

instructions, and regulatory agencies. 

Symbol Meaning Symbol Meaning 

 

Caution. 

 

Caution possibility of electric shock. 

 

Biological risks. 

 

Caution hot surface. 

 

Puncture/Pinch Point Warning 

 

Burn Hazard/Hot Surface 

 

Warning Laser Beam. 

 

Hand Crush/Force From Above 

 

Ionizing Radiation.  Fuse. 

 
Alternating Current. 

 

Use-by date. 

 

For Research Use Only. Not for 

use in diagnostic procedures.  
Batch Code. 

mailto:support@luminexcorp.com
http://www.luminexcorp.com/
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Symbol Meaning Symbol Meaning 

 

Conformite Europeenne (EU CE 

Marking of Conformity) CE 

conformity marking  
Manufacturer. 

 

Temperature Limit. 
 

Date of manufacture. 

 

Stand-by Power on/off. 

 

Protective earth; protective ground. 

 
Consult instructions for use. 

 
Catalog(ue) Number. 

 
Serial number. 

 

TÜV SÜD NRTL Certification Mark. 

 

WEEE Symbol. Separate 

collection for electrical and 

electronic equipment.  

MET Mark 
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Chapter 2: Regulatory and Safety 
Considerations 

Luminex recommends that all system users become familiar with the specific safety advisories and adhere to 

standard laboratory safety practices. Biological hazards may be present during system operation. 

 

The system contains electrical and mechanical components that, if handled improperly, can 

be harmful. 

 

 

Description 

The Luminex® MAGPIX® system is a life science research multiplex test system intended to measure and sort 

multiple signals generated in an assay from a biological sample. The MAGPIX system is for research use only 

and is not for use in diagnostic procedures. The MAGPIX system is for indoor laboratory and professional use 

only. 

 

 

Safety Testing and Certifications 

The MAGPIX® has been tested and complies with the safety requirements for the United States and Canada and 

is marked with the MET label or the TUV label. Review the Symbols Glossary to determine what the labels look 

like. 

The MAGPIX complies with the European Union (EU) safety requirements and therefore may be marketed in the 

Europe Single Market. 
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Regulatory and Safety Labels 

The following fuse caution label appears on the back of the system. 

Figure 1: Fuse Caution Label 

 

A voltage label appears on the back of the system and displays the serial number, model number, power 

requirements, and manufacturer’s information. 

Figure 2: Serial Number and Voltage Label 
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Warnings and Precautions 

 

Consult safety documentation where the caution symbol is marked. 

In any situation that you encounter a symbol shown below, consult this manual or other Luminex documentation 

to determine the nature of the potential hazard and any necessary actions you should take. 

General Safety 

 

The protection provided by the equipment can be impaired or the warranty voided if the 

system is used in a manner not specified by the Luminex documentation or by Luminex 

Corporation. 

Keep the side access door closed and latched during normal operations. Always observe 

standard laboratory safety practices. 

Do not, under any circumstances, remove the housing of the instrument. Use of controls or 

adjustments or performance of procedures other than those specified in MAGPIX® 

documentation can res- ult in exposure to hazards. 

Mechanical Safety 

 

The system has parts that move during operation. Risk of personal injury is present. The 

moving parts present puncture and pinching hazards. 

 

Keep hands and fingers away from the plate carrier slot, syringe pump and sample probe 

during operation. The plate carrier ejects without warning, especially during multi-plate 

batches. Observe all warnings and cautions. Keep the access door closed and latched during 

normal operations. 

Electrical Safety 

 

Observe the fuse caution stated on the fuse caution label. Be aware of the instrument 

voltage. 

Do not perform any maintenance or clean the electrical components in the system, with the 

exception of replacing fuses. 

Power cords must be replaced with cords of the same type and ratings as originally provided. 

Contact Luminex Technical Support for correct replacement power cords. 
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Electromagnetic Compatibility 

The MAGPIX® complies with the emission and immunity requirements described in IEC 61326-1 and IEC 61326-

2-6. The electromagnetic environment should be evaluated prior to operation. 

 

Do not use this instrument in close proximity to sources of strong electromagnetic radiation, 

for example, unshielded intentional RF sources, as these may interfere with the proper 

operation. 

 

Always handle the instrument according to Luminex instructions to avoid any possible 

interference from its electromagnetic fields. 

Barcode Reader Laser 

The accessory barcode reader is classified under FDA 21 CFR 1040.10 and 1040.11 as a Class 2 laser product. 

In accordance with IEC 60825-1:2014, the accessory barcode reader is classified as Class 2. 

The barcode reader laser presents a potential hazard to eyesight. 

 

Do not stare into the barcode reader beam or shine it into other people’s eyes. 

Heat Safety 

The heater plate, used to warm the plate carrier of the Y platform, can be heated between 35°C and 60°C. 

 

Do not use the heater plate as an incubator. Its purpose is to maintain the temperature of the 

plate while the plate is in the MAGPIX® instrument. Monitor the heater plate temperature 

while it is in use. If it overheats, discontinue use and contact Luminex Technical Support. 

 

The heater plate of the MAGPIX® plate carrier may be hot and can cause personal injury if 

touched. Do not touch the heater plate. 

Fluids Safety 

This system contains fluids. In the event of a fluid leak, turn off all power to the system and disconnect all power 

cords. The on/off switch is not a method of disconnection; the power cord must be removed from the outlet. 

Contact Luminex Technical Support for further information. 

Monitor waste fluid levels periodically as a precaution. Do not allow the waste fluid bottle to overflow. Empty the 

waste fluid bottle each time you replace the drive fluid bottle. 

 

Do not operate the instrument in the presence of leaking fluid. 

If biological samples have been tested with the system, user your standard laboratory safety 

practices when handling system waste. 
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Biohazard/Biological Safety 

Human and animal samples may contain biohazardous infectious agents. 

 

Where exposure to potentially biohazardous material, including aerosol, exists, follow 

appropriate biosafety procedures and use personal protective equipment (PPE). PPE 

includes gloves, gowns, laboratory coats, face shields or mask and eye protection, 

respirators, and ventilation devices. 

Observe all local, state, federal and country-specific biohazard handling regulations when 

disposing of biohazardous waste material. 

Samples and waste fluid can contain biohazardous infectious agents. Handle them at 

Biosafety level 2, as recommended for any potentially infectious human serum or blood 

specimen in the DCE/NIH manual, Biosafety in Microbiological and Biomedical Laboratories, 

1984. 

 

Although microspheres do not contain hazardous or carcinogenic components at toxic levels, 

they can be toxic if swallowed. In addition, contact with acids liberates toxic gases. If 

microspheres come into contact with skin, wash immediately with copious amounts of water. 

In case of an accident, seek medical advice immediately and show the product label or bottle 

to your medical provider. A safety data sheet (SDS) is available upon request. 

NOTE: Do not use strong organic solvents with the system. Contact Luminex Technical Support when in doubt 

about compatibility of cleaning and decontamination agents or materials. 

Indicator Light 

The indicator light inside the front panel of the MAGPIX® indicates the status of the system and are harmless. The 

blue light-emitting diodes (LEDs) do not emit light in the UV spectrum. 
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Chapter 3: Performance Specifications 
and System Components 

General System Workflow 

The mechanical system. A user places a plate on the plate carrier, which transports the plate into the 

instrument. The plate carrier moves along the y-axis, to allow the sample probe access to each column of the 

plate. The sample probe assembly moves along the x and z axes, allowing the sample probe to access each well 

of the plate. Between the y-axis movement to the plate carrier and the x-axis movement of the sample probe, all 

wells of the plate are accessible. 

The fluidics system. The sample probe descends into each well of the plate, acquires a sample for testing and 

acquires drive fluid from the drive fluid bottle. The sample moves through the fluid tubing to the optics system, 

transported by the drive fluid. 

The optics system. A magnet holds the magnetic microspheres in place while first a red (classification) LED and 

then a green (reporter) LED illuminate the microspheres. The microspheres are imaged during illumination. After 

the images are recorded, the magnet withdraws, releasing the microspheres for transport to the waste fluid bottle 

and to clear the path for the next sample. 

 

 

Environmental Conditions 

• Indoor and professional use only 

• Operating temperature: 15°C to 35°C (59°F to 95°F) 

• Shipping and Operating relative humidity: 20% to 80%, non-condensing 

• Operating altitude: up to 2400 m (7874 ft) above mean sea level 

• Shipping temperature: 0°C to 50°C (32°F to 122°F) 

• Storage temperature: 10°C to 40°C (50°F to 104°F) 
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Performance Specifications 

General System Specifications 

• Start-up time: Under 15 minutes, including flushing system lines, system calibration, and system 

verification 

• System verification: 5 minutes 

• Shutdown time: Under 15 minutes 

• Time to complete one 96-well plate: Under 1 hour with 50 regions, 2000 microspheres per region per well, 

counting 50 microspheres in each region, aspirating 30 µL out of a 75 µL sample 

• Physical Dimensions: 20.3 cm (8 in) width, 66 cm (26 in) depth, 43.2 cm (17 in) height 

• Weight: 18.0 kg (40 lbs) 

• Installation Category II 

• Pollution degree 2 

• Temperature control: maintains samples using the heater block at a constant temperature from 35°C to 

60°C (95°F to 131°F) +/- 1°C of setpoint. 

• Automatic transfer of assay protocols and new reagent information into the system using a large capacity 

read/write DVD 

• Automatic sampling from a 96-well plate, beginning from any well position 

• Automatic real-time analysis 

• Analysis of multiple assay protocols per plate 

• Barcode reader entry of sample IDs 

• Produces sound pressure levels below 85 dBA 

Electronics Specifications 

• USB 2.0-compatible communications link for fast data transfer 

• Input voltage range: either 100 V to 120 V~, 2.0 A, 50 Hz to 60 Hz or 200 V to 240 V~, 1.0 A, 50 Hz to 60 

Hz 

Optics Specifications 

• Reporter channel detection: A/D resolution 12 bits 

• Reporter detector: xMAP® imager, detection bandwidth of 566 to 614 nm 

• Classification detector: xMAP® imager  

• Limit of Detection (LOD): For the reporter channel, using a blank microsphere from region 078, ≤ 700 

molecules of phycoerythrin (PE) per microsphere 

• Reporter Channel Dynamic Range: use a microsphere from region 078, ≥ 3.0 decades 

• Efficiency: Classification Channels: ≥ 80% 
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Fluidics Specifications 

• Sample load rate: 20 µL  to 500 µL  per second 

• Sample uptake volume: 20 µL  to 200 µL  

• Well-to-well carryover: ≤ 4% 

• Sample uptake accuracy: +/- 5% 

Microspheres Specifications 

• Distinguishes 1 to 50 unique MagPlex® microspheres in a single sample 

• Misclassification Rate ≤ 2% 

• Classification Rate ≥ 80% 

• Detects and distinguishes surface reporter fluorescence emissions at 590 nm +/- 24 nm on the surface of 

1 to 50 unique MagPlex microsphere in a single sample 

• Soluble background fluorescence emission at 590 nm +/- 24 nm automatically subtracted from 

fluorescence intensity values 

• Internal sample carryover: < 1.5% 

• Detects a minimum of 500 fluorochromes of Phycoerythrin (PE) per xMAP microsphere 

Plates Specifications 

• Plate must be 96-well, not to exceed 2.54 cm (1 in) in height, including heater block. 

• Plate must be compatible with the heater block temperature when the heater block is in use. 

• All plates have standard width (85.5 mm) and length (127.9 mm). 

• Depth varies depending on the type of well. Maximum allowable depth is 2.54 cm (1 in). 

• Plates must have minimum 1.5 mm (0.06 in) lip height, standard distance from well center to well center (9 

mm (0.35 in)) and standard distance from A1 center to plate center in both length and width. 

• To be compatible in size with the heater block, the plate must fit into the heater block so that the top is 

flush with the heater block. 

 

 

System Components 

The three components of the MAGPIX® system are: software, hardware, and reagents. 

Software Component 

xPONENT® software provides complete control of the system and performs the analysis. The software requires a 

dedicated PC. For updated information about the PC or operating system, refer to the software release notes, or 

access http://www.luminexcorp.com. 

Under most circumstances, the PC that comes with the MAGPIX® system is preloaded with xPONENT for 

MAGPIX soft- ware. Luminex provides software on media to use if you need to reinstall the software or need to 

http://www.luminexcorp.com/
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install it on another computer. 

The software media automatically installs the 21 CFR and Security modules on a temporary license. The 21 CFR 

and Security modules are only active for 90 days. If you do not purchase a permanent license key for 21 CFR and 

Security modules, then you will not need a user ID and password to access the basic functions of the software. 

Contact Luminex Technical Support if you choose to purchase the 21 CFR and Security Modules. 

 

If you need to uninstall, reinstall, or install additional instances of xPONENT®, please contact 

Luminex Technical Support. Versions of xPONENT are only compatible with specific xMAP® 

instruments. Use of an incompatible version of xPONENT may lead to calibration or 

performance verification failure and is not a supported configuration. Before performing any 

software uninstall or installation steps, contact Luminex Technical Support to ensure that 

hardware and software versions are fully compatible and supported. 

The software is documented in online help, which can be accessed from within the application itself, in PDF form, 

which is available on the Luminex website, and on media included with the shipped system. 

 

Luminex recommends that you do not install additional software on the PC that runs 

xPONENT, with the exception of Adobe Acrobat. Acrobat is required to view the PDFs and is 

included on the installation DVD. The operation of xPONENT for MAGPIX has been validated 

only when it is the only program running on the dedicated PC. 

Hardware Components 

The MAGPIX® system includes the following hardware: 

• The MAGPIX instrument 

• Personal computer (PC) and necessary peripherals, including a monitor, keyboard and mouse 

• Power cable to connect MAGPIX to power outlet 

• USB communication cable to connect MAGPIX to PC 

• Two sample probes 

• Sample probe height adjustment kit 

• Off-plate reagent block 

• Additional empty waste fluid bottle 

• Side door access tool 

• Barcode reader (optional) 

• Heater block (optional) 

The hardware is shipped with a quick installation guide, a quick software user guide, the software and hardware 

user manual, and the software. 
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Consumable Components 

xMAP® Technology Reagents 

 

Protect MAGPIX® calibration and verification reagents from light at all times to avoid 

photobleaching of the microspheres. 

MAGPIX Drive Fluid and the solution in which microspheres are stored contain ProClin®, 

which may cause an allergic reaction. Use personal protective equipment (PPE), including 

gloves and safety glasses. Check the assay package insert for assay component information. 

Additional information is available in the drive fluid SDS. 

MAGPIX Drive Fluid PLUS contains, and other laboratory reagents can contain, sodium 

azide as a preservative. Sodium azide may react with lead and copper plumbing to form 

highly explosive metal azides. Refer to local guidelines and regulations for proper disposal of 

unused and used MAGPIX Drive Fluid PLUS, as well as other laboratory reagents containing 

this preservative. 

 

Adhere to standard laboratory safety practices when handling hazardous, toxic, or flammable 

reagents and chemicals. Contact Luminex Technical Support when in doubt about 

compatibility of cleaning and decontamination agents or materials. 

Only use reagents, assays, or other consumables that are within their expiration date. 

Dispose of all expired reagents, assays, or consumables in the appropriate waste fluid 

container. 

• MAGPIX® Drive Fluid or MAGPIX Drive Fluid PLUS (unit volume sufficient to run eight 96-well plates) 

• MAGPIX Calibration Kit (to normalize the CL1 and CL2 classification channels and the RP1 reporter 

channel parameters) 

• MAGPIX Performance Verification Kit (to verify system integrity associated with the CL1 and CL2 

classification channels, the RP1 reporter channel, and the system fluidics). 

MAGPIX is shipped with a 2-pack of drive fluid. A MAGPIX Calibration Kit and a MAGPIX Performance 

Verification Kit are shipped separately. 

Required Laboratory Reagents 

 

Isopropanol and ethanol are flammable liquids. Keep them away from heat, open flames, and 

sparks in a well-ventilated area. Remove them from the instrument when they are not in use. 

Formulated reagents must be free of particulates other than xMAP® microspheres. Do not 

dilute xMAP calibrators or verifiers. 

Refer to the manufacturer's documentation and your site's operating procedures when 

preparing, storing, and handling reagents. 

• 0.6% sodium hypochlorite solution with no additives 
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NOTE: Sodium hypochlorite solutions containing small amounts of sodium chloride (NaCl), sodium 

carbonate (Na2CO3), sodium hydroxide (NaOH), and other pH buffers may be used. Do not use sodium 

hypochlorite solutions containing film-forming agents, such as Diallyldimethylammonium Chloride 

(DADMAC), or other additives.   

• 70% isopropanol or 70% ethanol solution 

• Sodium hydroxide (0.1N NaOH) 

• Sporicidin® Disinfectant 

• Mild detergent 

• Distilled water 

 

 

Subsystems 

Mechanical Subsystem 

x-Axis and y-Axis Movement 

The mechanical subsystem includes the plate carrier and the assembly that moves the sample probe. The carrier 

moves along the y-axis, to allow the sample probe access to each row of the plate. The sample probe assembly 

moves along the x and z axes, allowing it to access each column of the plate. Between the y-axis movement of 

the carrier and the x- axis and z-axis movement of the sample probe, all wells of the plate are accessible. 

Figure 3: Plate Carrier Assembly 

 

 

1. Plate area 

2. Off-plate reagent block area 
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Figure 4: Sample Probe Assembly 

 

 

1. 
Pulley wheel that moves sample probe assembly 

along x-axis (cover removed) 

2. Sample probe 

 

Air Filters 

The MAGPIX® has two air filters, one on the bottom of the instrument and one on the back of the instrument. 

These filters require periodic cleaning to perform optimally. 

Lift or tilt the MAGPIX forward to slide the bottom filter out of its holder toward the front of the instrument. Slide the 

back filter up and out of its holder. 

 

Before lifting the instrument, remove the fluid bottles, the off-plate reagent block, and the 

sample plate. 

Electrical Subsystem 

The electrical subsystem provides the power for operation and control of the MAGPIX® system and 

communication between its parts. 
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Power Input Module 

The power input module contains the input power plug, hard power toggle switch, and fuses. The power input 

module is the protective earthing point for the MAGPIX® system. The mating power cord connector type is IEC-

320-C13. The mating power cord provides electrical power to the instrument when it is connected to an electrical 

outlet and is the means of disconnection. The power input automatically senses the voltage range. 

Figure 5: Power Input Module 

 

 

1. Hard power toggle switch 

2. Input power plug 

 

 

Do not obstruct this means of disconnection. Connect only to outlets that contain protective 

earthing. Before changing a fuse, turn off the instrument and unplug the power cord to avoid 

any danger of electrical shock. 

Communications Port 

The communications port connects the MAGPIX® to the computer. It is a USB port, labeled P1. 

Figure 6: Communications Port 
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Fluidics Subsystem 

The fluidics subsystem handles the flow of liquid through the MAGPIX®. The MAGPIX has two doors that access 

its fluidics system: a side access door and a front door to the fluid compartment. 

Side Compartment and its Components 

The side compartment of the MAGPIX® contains the majority of user-maintainable components. 

The side access door, at the upper front of the right side, provides access to the side compartment, which 

provides access to the majority of user-maintainable components: the sample probe assembly, the sample valve, 

the tube between the probe and the sample valve, the filter for the drive fluid, and the syringe pump. The side 

access door to this compartment must remain latched during operation of the instrument. Opening the side 

access door requires a special tool provided with the MAGPIX system. 

 

Keep the side access door closed and latched during normal operation. Unlatch it only to 

perform maintenance on the user maintainable parts of the fluidics system. 

 

Figure 7: Side Access Door 
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Figure 8: Interior of Side Access Door 

 

 

Fluid Compartment 

At the bottom of the front panel of the MAGPIX®, a door folds down to provide access to the fluid compartment. 

Within that compartment, two trays hold the drive fluid and waste fluid bottles. Internal sensors monitor the 

fullness of the waste fluid bottle and the emptiness of the drive fluid bottle. When either container reaches an 

unacceptable level, the MAGPIX stops. Set up an alert to warn you about unacceptable fluid levels. 

Figure 9: Door to Fluid Compartment 

 

The drive fluid bottle comes pre-filled and is disposable. The reusable waste fluid bottle receives waste from the 

system. The waste and drive fluid tubes connect to the waste fluid and drive fluid bottles using clear tubing. 

 

Wear appropriate personal protective equipment (PPE) when handling parts that come into 

contact with potentially biohazardous samples. Make certain the waste fluid container is 

properly vented. 
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Figure 10: Fluid Compartment, Interior 

 

 

1. Drive Fluid bottle in place 

2. Waste fluid bottle in place 

3. Valve attaching waste tubing to waste fluid bottle 

Sample Probe Assembly 

The stainless steel sample probe fits inside a holder. A probe fitting screws into the top of the holder, keeping the 

probe in place. From the probe, through the fitting, extends a tube that passes through a strain relief and attaches 

to the sample valve. The sample loop from the syringe pump also enters the sample valve, and a tube extends 

from it into the optical chamber, carrying the sample mixed with drive fluid. 

A wheel pulley, covered by a protective shield, moves the sample probe assembly along the x-axis. 
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Figure 11: Sample Probe Assembly 

 

 

1. Sample loop 6. Sample valve 

2. Strain relief 7. Protective cover on wheel pulley 

3. Probe-to-valve tube (coded black) 8. Probe holder 

4. 
Valve-to-optical chamber tube (coded 

red) 
9. Probe fitting 

5. Sample probe    

 

 

Avoid contact with moving parts. 

 

Wear appropriate personal protective equipment (PPE) when handling parts that come into 

contact with potentially biohazardous samples. 
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Syringe Pump and Drive Fluid Filter 

The syringe pump draws fluid from the drive fluid bottle, in the bottom compartment of the instrument. The fluid 

first passes through the drive fluid filter, which removes particles greater than 35 microns in diameter. 

The pumping action results from the up-and-down movement of the plunger guide in its mounting bracket, which 

moves the plunger up and down in the glass cylinder, drawing drive fluid in through the filter and into the valve 

and forcing it out into the sample loop. 

Figure 12: Syringe Pump and Drive Fluid Filter 

 

 

1. Drive Fluid filter 5. Mounting bracket 

2. Plunger 6. Plunger guide 

3. Tube from Drive Fluid bottle 7. Syringe pump valve 

4. Glass cylinder 8. Sample loop 

 

 

Avoid contact with moving parts. 
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Optical Subsystem 

The optical subsystem consists of red and green LED illumination, an xMAP® imager, an imaging chamber, and a 

magnet to hold the magnetic microspheres in place during the imaging process. The optical subsystem is 

contained in the same area as the PCBAs. The optical subsystem is not accessible by the user and requires no 

user maintenance. 

PC Specifications 

For updated information regarding the PC operating system, go to: www.luminexcorp.com. 

 

 

Recommended Additional Equipment 

Successful operation of the system may require additional equipment. 

Uninterruptible Power Supply (UPS) or Surge Protector - Luminex recommends using either an uninterruptible 

power supply (UPS) or a surge protector to protect your system from power outages. Use a UPS that provides 

585 Watts/960 VA for at least 60 minutes. Choose a surge protector that fits the requirements for electrical 

environment, endurance, suppressed voltage rating, and method of protection. The surge protector requires three 

outlets and a minimum rating of 585 Watts. Both pieces of equipment should include appropriate safety 

certification marks for your region, for example, Underwriters Laboratory (UL) or a similar listing body, certified by 

Canadian Standards Association (CSA), or Conformité Europeénne (CE) for non-domestic use. 

Printer - Use a printer compatible with the version of Microsoft® Windows® running your PC with xPONENT®. 

Refer to the xPONENT release notes for the specific version of Windows. 

Barcode Labels - Use Code 128 barcode label type when scanning barcode labels into the system. Vortex - Use 

VWR product number 58816-12, with a speed range of 0 to 3200 rpm, or equivalent. 

Vortex - Use VWR product number 58816-12, with a speed range of 0 to 3200 rpm, or equivalent. 

Bath Sonicator - Use Cole-Parmer® product number 08849-00, with an operating frequency of 55 kHz, or 

equivalent. 

http://www.luminexcorp.com/
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Chapter 4: Installing the System 

The MAGPIX® Overpack 

The MAGPIX® overpack contains the following items: 

Item Quantity Part Number 

MAGPIX® Instrument 1   

PC 1   

Monitor 1   

MAGPIX® Drive Fluid PLUS, 2-pack 1 40-50022 

Waste Bottle 1 CN-0261-01 

Sample Probe 2 CN-0221-01 

Power Cord 1 CN-P0XX-01 

USB Cable 1 CN-0271-01 

Side Access Door Tool 1 CN-0264-01 

Sample Probe Height Adjustment Kit 1 CN-0263-01 

MAGPIX® Off-plate Reagent Block 1 CN-0260-01 

xPONENT® 4.3 Software for MAGPIX® 1 CN-SW65-01 

MAGPIX® RUO CD 1 89-30000-00-034 

PC Connection Instructions 1 89-00002-00-611 

Terms and Conditions 1 89-30000-00-739 

96-wellplate Heater Block (optional) 1 CN-0224-01 
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Item Quantity Part Number 

Barcode reader (optional) 1 CN-PC03-01 

NOTE: A MAGPIX Calibration Kit and a MAGPIX Performance Verification Kit are shipped separately. 
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System Diagram 
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Unpack the System Components 

Before unpacking the MAGPIX®, ensure that where you plan to install the system complies with the environmental 

conditions and meets the site installation requirements. 

 

The overpack is too heavy to be lifted by one person (approximately 53.97 kg [119 lbs], a 

three-person lift) and should be moved mechanically. Be careful the overpack is not 

punctured during any necessary moving. 

The MAGPIX arrives in a large, corrugated cardboard overpack on skids. The overpack contains separate boxes 

for the PC, the monitor, the 2-pack of drive fluid, and the MAGPIX instrument. In addition, a divided tray contains 

the cables, CDs, and printed material. Each individual box can be handled by one person. The MAGPIX box and 

the PC each weigh less than 18.14 kg (40 lbs). 

1. Remove the three boxes from the overpack that contain the PC and all of its components. 

2. Remove the MAGPIX box from the overpack. The MAGPIX instrument is inside a plastic bag and 

surrounded by foam inserts attached to a corrugated cardboard insert. 

a. Pull the handles that extend from the cardboard insert. 

NOTE: Luminex recommends to have another person hold down the box while you pull the 

MAGPIX out. 

b. Place the MAGPIX box on a flat, stable surface, using two people. 

c. Fold down the cardboard panels from each side of the instrument. 

d. Pull the plastic bag down from the top of the MAGPIX. 

e. Place the MAGPIX onto a lab bench or other flat, stable surface, using two people. 

Before proceeding with the installation, check the contents of the overpack with the Shipping Checklist and make 

certain you can locate all listed items. Check contents to make certain no damage has occurred during shipping. If 

anything is missing or damaged, contact Luminex Technical Support. 

 

 

Assemble the System 

The computer and monitor boxes include all the necessary cords and peripheral devices as well as complete 

installation instructions. 

1. Assemble the PC and its components using the instructions provided by the PC vendor. 

2. Locate the cords in the accessory tray of the overpack. 

a. Plug the power cord into the back of the MAGPIX®. 

b. Connect the USB cable to the USB card on the back of the PC and to the connector labeled P1 on 

the back of the instrument. 
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c. Connect the barcode scanner (if ordered) to the PC and to a USB port on either the front or back. 

 

 

Remove the Shipping Plug 

Inside the side access door of the MAGPIX®, a shipping plug holds the sample probe assembly in place. Use the 

door access tool included in the accessory tray to open the side access door and remove the plug. 

 

MAGPIX® should not be plugged into a power source when you open this compartment. 

To open the side access door and remove the shipping plug: 

1. Locate the door access tool in a small plastic bag in the accessory tray of the overpack. 
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2. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to the 

right. 

 

3. Raise the sample probe assembly and locate the shipping plug. 
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4. Pull the sample probe holder up, then, holding the MAGPIX on the top with one hand to stabilize it, firmly 

push the sample probe assembly away from you with your other hand. Be prepared to use some strength. 

 

5. With the sample probe assembly out of the way, lift out the shipping plug. 

 

 

 

Install the Sample Probe 

MAGPIX® comes with two sample probes, but the sample probe is not pre-installed.  

To install the sample probe: 

1. Locate the sample probe, which is shipped in a tube in the accessory tray. 



 

30 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

 

2. Pull the sample probe assembly toward you and push it down. 

3. Completely unscrew the sample probe fitting on top of the sample probe holder by turning it 

counterclockwise. 

 

4. Place the sample probe into the opening left by the sample probe fitting. It should slip down and catch at 

the bottom of the opening. 
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5. Reinstall the sample probe fitting, tightening it until it clicks into place. 

 

6. Close and latch the side access door. 

 

 

Install the Drive Fluid 

The overpack includes a box containing two bottles of drive fluid. Open the box and remove one bottle to install in 

the MAGPIX®. 

1. Locate the box of drive fluid bottles. 

 

2. Open the box and remove a bottle of drive fluid. 

3. Open the door of the fluid compartment on the front of the MAGPIX®. 

4. Pull the drive fluid tube and plug (1) in the left side of the fluid compartment forward until it extends outside 

the compartment. Pull it to the left to allow room to insert the drive fluid bottle. 
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5. Insert the drive fluid bottle part of the way into the fluid compartment opening and remove the seal. 

6. Connect the drive fluid tube and plug to the opening on the top of the drive fluid bottle. 

 

7. Slide the bottle into the tray on the left side of the fluid compartment. The tray is constructed to hold the 

bottle in place. 

 

8. After the bottle is fully inserted, check the valve on the front of the waste fluid bottle to make certain it is 

securely attached and close the door of the fluid compartment. 
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Chapter 5: Preparing the System 

xPONENT® for MAGPIX® contains pre-defined routines to prepare the instrument for data acquisition. 

 

 

Parts of the System 

Figure 13: Front and Right Side 

 

 

1. Status Indicator Light 4. Access Door for Fluid Compartment 

2. Soft On/Off Switch 5. Side Access Door 

3. Access Door for Plate Carrier 6. Side Access Door Latch 

  



 

34 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Figure 14: Back and Left Side 

 

 

1. Communications Port (P1) 

2. Power Input Module 

3. Rear Air Filter 

 

 

Power on the System 

MAGPIX® has two on/off switches: a hard power switch and a soft power switch. To power on the MAGPIX: 

1. Turn on the PC desktop. 

2. Plug the power cord from the back of the MAGPIX instrument into a power outlet.  

NOTE: Luminex recommends the use of a surge protector or Uninterruptible Power Supply (UPS) device. 

3. Turn on the hard power switch (1), which is located at the lower right back corner of the MAGPIX.  

NOTE: The hard power switch controls flow of power to the instrument. 



 

35 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

 

4. When you are ready to begin testing, turn on the soft power switch (2) on the front of the MAGPIX. The 

blue LED in the hexagonal window (3) lights up as confirmation that the power is on. The MAGPIX 

requires approximately 45 seconds to start up. 

 

NOTE: The soft power switch activates and deactivates the unit. 

 

 

Log into the Software 

If you ordered a PC from Luminex, xPONENT® will be installed with 21 CFR and Security Modules on a 

temporary license. Use the default user ID and password to access the software: 

User ID: admin  

Password: xponent 

Once an application administrator updates the user ID and password, the default user ID and password will not be 

active. 

The 21 CFR and Security modules are only active for 90 days. If you do not purchase a permanent license key for 

21 CFR and Security modules, then you will not need a user ID and password to access the basic functions of the 

software. 
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NOTE: Contact Luminex Technical Support if you have problems logging on. If you want to purchase a license for 

21 CFR Part 11 or the security module, contact Luminex to place an order. 

 

Use of this software by untrained personnel can result in inaccurate data and test results. 

Users of xPONENT must read the documentation thoroughly before operating the software. 

1. On the PC desktop, double-click the Luminex xPONENT icon. 

2. If this is the first time you have started the software, read the User License Agreement. Select I accept the 

terms of this license agreement, then click OK. 

3. Enter your User ID on the System Login tab. 

4. Enter your password if you are using a secure version of the software. 

5. Click Log In. The Home page displays. 

 

 

Adjust the Sample Probe Height 

Adjust the sample probe height to ensure that the sample probe drops far enough in the well to acquire sample. 

NOTE: Ensure that there is no liquid in the wells or reservoirs before adjusting the sample probe height. 

NOTE: When you adjust and save the sample probe height settings for all three areas under a plate name, all 

areas retain the adjustment. 

 

Correct sample probe height is critical to successful sample acquisition and calibration. 

Problems with the sample probe height can lead to fluid leaks and inhibit sample acquisition. 

Ensure that the sample probe height is set correctly before calibrating or verifying the system. 

1. From the Home page, under Daily Activities, click Probe and Heater. 

2. On the Probe and Heater tab select well D6 (this is the center of a standard 96-well plate) on the plate 

image. A green pin marks the selected well. 

3. Based on the type of plate you are using, place alignment disks or an alignment sphere in the well. 

• for a standard 96-well plate - None 

• for a filter-bottom plate - two 5.08 mm disks 

• for Mylar-bottom plate - two 5.08 mm disks 

• for a conical (v-bottom) plate - one sphere 

4. Click Eject. 

5. Place the off-plate reagent block on the plate carrier. Make sure the plate is well seated so that it clips into 

place. 

6. Place a strip well (provided with the Calibration and Performance Verification kit) in the off-plate reagent 

block. 

7. In the Strip Wells section, select SD1. 

8. Verify that the reservoir is empty. 

9. In the Reservoir section, select well RB1. 
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NOTE: Verify that the plate is not warped. Warped plates can lead to incorrect probe height adjustment. 

10. Place the plate on the plate carrier with well A1 positioned as indicated on the plate carrier. 

11. Click Retract. 

12. Enter a name for the plate in the Plate Name field. 

13. Click Auto Adjust Height. The sample probe automatically adjusts itself to the locations you chose. 

NOTE: The sample probe height is automatically set to 0.98 mm. The sample probe automatically adjusts 

this distance from the bottom of the plate, or calibration disks or spheres. 

14. Click Eject. If you used alignment disks or spheres, remove them from the plate. 

Run the Revive After Storage Routine 

NOTE: The Revive After Storage routine is necessary when the system runs for the first time and is 

recommended when the system has been idle for more than a week. 

After you have adjusted the sample probe height, run the Revive After Storage (Luminex) routine. 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. From the Routine Name drop-down menu, choose Revive After Storage (Luminex). The Revive After 

Storage routine performs the following commands: 

• Prime 

• Rinse 

• Alcohol Flush 

• Backflush 

• Wash 

3. Click Eject. 

4. Fill reservoir RB1 3/4 full of 70% isopropanol or 70% ethanol.  

NOTE: The rinse reservoir (RD1) should be empty. 

5. Click Retract. 

6. Click Run. 

Import Calibration or Performance Verification Kits 

1. Load the CAL/VER CD (provided with the kit) on the computer. 

2. From the Home page, click System Initialization. 

3. Click Import Kit at the bottom right side of the window. The Import Calibration or Performance Kit 

dialog box opens. 

4. Choose the MPX folder and click Open. 

5. Choose the *.lxl file and click Open. 

6. Click OK. 

Delete Calibration or Performance Verification Kits 

1. Navigate to the Maintenance page > Lot Management tab. 
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2. In the Active Reagents section, choose the kit you want to delete from the Calibration Kit or Performance 

Verification Kit drop-down menus. 

3. Click Delete Kit. 

4. Click OK in the Delete Kit dialog box to confirm you want to delete the kit. 

 

 

Calibrate the System 

Calibration is important to ensure the optical system functions effectively and different MAGPIX® systems report 

similar results. Calibrating the MAGPIX system normalizes the settings for the classification channels (CL1 and 

CL2) and the reporter channel (RP1). Use the MAGPIX Calibration Kit to calibrate the system. Following 

calibration, use the MAGPIX® Performance Verification Kit to check all of the optical channels in the system for 

correct calibration. Be sure to verify every time you calibrate. If there is a problem with optical integrity or fluidics, 

MAGPIX may pass calibration but fail performance verification. 

If the system is not fully calibrated, a warning message displays. Track the system calibration and verification 

results through the Calibration and Verification report. Target value information for calibration and verification 

microspheres is available on the media that comes with the calibration kit and on the Luminex website at 

www.luminexcorp.com. 

Calibrate the system at least once a week using the Calibration Verification button on the Maintenance page > 

Auto Maint tab. In addition, recalibrate the system if any of the following occur: 

• The delta calibration temperature exceeds +/- 5°C. 

• The instrument is moved. 

• You experience sample acquisition problems. 

• The instrument undergoes hardware maintenance, such as replacement of a part. 

Calibration normalizes the settings for the system and ensures optimal and consistent microsphere classification. 

1. From the Home page, click System Initialization. The Auto Maint tab displays. 

2. Select Calibration Verification option under Automated Maintenance Options. 

3. Choose the appropriate calibration kit from the drop-down menu. 

4. Vortex the xMAP® calibrator and fluidics bottles at a medium speed for approximately 10 seconds to 

ensure homogeneity. Do not dilute the xMAP calibrator or fluidics agents. 

5. Click Eject. 

NOTE: The plate layout in the software indicates reagent locations. 

6. Fill the appropriate reservoirs 3/4 full of DI water and 3/4 full of 70% isopropanol or 70% ethanol.  

NOTE: The plate layout in the software indicates reagent locations. 

7. Invert the calibrator vial perpendicular to the strip well to ensure you get the necessary bead count. 

8. Add 6 drops of the reagent into the designated well 

9. Fill reservoir RB1 3/4 full of 70% isopropanol or 70% ethanol. The rinse reservoir (RD1) should be empty. 

10. Click Retract. 

11. Click Run. Once complete, click OK. 

 

 

http://www.luminexcorp.com/
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Verify the System 

The MAGPIX® Performance Verification Kit includes reagents to verify the calibration and optical integrity for the 

MAGPIX system as well as reagents to verify the fluidics channels using observations of pressure, flow rate, bead 

count and well-to-well carryover. 

Run the Performance Verification routine as part of your daily startup routine. Refer to your assay kit instructions 

for additional calibration frequency requirements. 

Verification uses system verifiers to ensure that the instrument is functioning properly with current calibration 

settings. 

1. From the Home page, click System Initialization. The Auto Maint tab displays. 

2. Select the Performance Verification option under Automated Maintenance Options. 

3. Choose the appropriate performance verification kit from the drop-down menu. 

4. Vortex the xMAP® performance verification reagents and fluidics bottles at a medium speed for 

approximately 10 seconds to ensure homogeneity. Do not dilute the xMAP verification or fluidics agents 

5. Click Eject. 

NOTE: The plate layout in the software indicates reagent locations. 

6. Add 6 drops of each reagent into the designated well. 

7. Fill reservoir RB1 3/4 full of 70% isopropanol or 70% ethanol. The rinse reservoir (RD1) should be empty. 

8. Click Retract. 

9. Click Run. 
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Chapter 6: Running the Assay 

General Software Guidelines 

 

Modifying or deleting xPONENT® system files can cause degradation of system performance. 

Repair modified or deleted xPONENT system files by uninstalling and re-installing the 

xPONENT software. Luminex recommends that you contact Luminex Technical Support 

before uninstalling and reinstalling xPONENT. 

Using unauthorized third-party software with xPONENT software can result in corruption or 

failure of the xPONENT software. Use third-party software at your own risk. The operation of 

the system software is validated only when it runs alone on the dedicated PC. 

If you are using a screen saver on the PC on which xPONENT is installed, xPONENT 

prevents it from activating. A dialog box opens each time xPONENT is launched, 

recommending that the screen saver and any power management settings be turned off. 

Versions of xPONENT are only compatible with specific xMAP® instruments. Use of an 

incompatible version of xPONENT may lead to calibration or performance verification failure 

and is not a supported configuration. Before performing any software uninstall or installation 

steps, contact Luminex Technical Support to ensure that hardware and software versions are 

fully compatible and supported. 

 

 

Define the Protocol 

NOTE: When running a kit with a provided protocol, the protocol for the assay must be run as instructed in the 

assay's package insert. 

Create a New Protocol 

1. Navigate to the Protocols page > Protocols tab > click Create New Protocol. 

2. On the Settings subtab, fill in the details of the assay for proper analysis. 

a. Enter the Name of the protocol. 

b. The Version field defaults to 1. 

c. Enter the Manufacturer. 

d. Enter a Description. 

e. Enter the Volume for the instrument to aspirate into the system. 

f. Select Enabled to enable the XY Heater and then enter the value in degrees C. 
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g. Choose the Plate Name that was assigned to the plate during probe height adjustment. 

h. Select Sample Wash to wash the samples. 

i. For Analysis Type, choose the type of protocol you want - None, Qualitative, or Quantitative. 

j. If you chose quantitative analysis type, enter the Number of Standards that apply to the protocol. If 

you chose qualitative analysis type, the field defaults to 1 and is un-editable. 

k. If you chose qualitative or quantitative analysis type, enter the Number of Controls that apply to 

the protocol. 

l. If you chose quantitative analysis type, select the option of Fit of All Standards or Mean of 

Replicates to apply to the protocol. 

m. Select Analyze results while acquiring samples to view the results while the samples are being 

analyzed. 

n. Select Use External Analysis Program, if you plan to use an external analysis program to analyze 

the results. 

i. If you chose to use an external analysis program, the Analysis Program drop-down menu 

enables for you to choose a program. 

o. Once all the settings have been chosen on the Settings subtab, click Next. 

3. On the Analytes subtab, fill in the details of the assay for proper analysis. 

a. Select the analytes in the analytes grid. 

b. For Default Analysis, click Change to change the default analysis. 

c. For Units, enter the desired units for the analytes. If the units applies to all analytes, click Apply All. 

d. For Count, enter the desired bead count the instrument will analyze from the sample until it has 

reached the count chosen for each bead region. If the bead count applies to all analytes, click 

Apply All. 

e. Click in the Name field of each analyte, and enter a new name if you choose. 

f. Once you are done setting up the Analytes tab, click Next. 

4. On the Plate Layout subtab, fill in the details of the assay for proper analysis, or click Save if you chose 

None for the analysis type. 

a. Select the wells in the plate image, assign well commands to the selected wells, and then choose 

the Replicate Count and Grouping. 

b. If you have more than one plate, click Add Plate to add another plate. 

c. Choose the Direction to run the plate commands. 

d. Click Import List to import an existing command sequence list. 

e. Click Save. 

Edit Quantitative Analysis Settings 

1. Navigate to the Protocols page > Protocols tab. 

2. Choose a quantitative protocol from the Installed Protocols list and click Edit. 

3. If desired, enter a new protocol name and description in the appropriate fields. 

4. Enter a new version number in the Version field. 

5. Edit the manufacturer if needed. 

6. Edit the Acquisition Settings and Analysis Settings as necessary. 

7. Click Next to display the Analytes subtab. 
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8. From the Analytes subtab, click an analyte’s Analysis field to open the Analysis Settings dialog box, 

and edit as needed. 

a. Choose an analysis method in the Method drop-down menu. 

b. Choose a weight type in the Weight Type drop-down menu (Weight Type may not display, 

depending on the analysis method selected in the Method list). 

NOTE: If you want an analyte to be an Intra-Well Normalization Bead, select Mark as Intra-Well 

Normalization Bead. The normalization bead is a microsphere set that is included in the assay as 

an internal control. It controls for sample variation and can be used to normalize data between 

samples in a run. 

c. Click OK to apply the new settings to only the analyte selected, or Apply to All Analytes to apply 

the settings to all of the analytes in the protocol. 

9. If you want to use a range for the analysis, click the Analysis field for the analyte you want to modify. The 

Analysis Settings dialog box displays. 

a. Select Use Threshold Ranges if you want to use a range for the analysis. 

b. Click Add Range to setup the threshold range. 

c. Enter a name for the range in the Range Name field. 

d. Enter low and high range values in the Low Value and High Value fields. 

e. Select the check box in the Inclusive columns to include the value in the range, or leave it clear to 

make the range value one unit higher than the low value, and one unit lower than the high value. 

f. If you need to delete a range, highlight a range and click Delete Range. 

g. Click OK to apply the threshold range to the analyte. 

10. Click Next. The Plate Layout subtab displays. 

11. Assign commands and routines to the plate layout. 

12. Click Save. 
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Edit Qualitative Analysis Settings 

1. Navigate to the Protocols page > Protocols tab. 

2. Choose a qualitative protocol from the Installed Protocols list and click Edit. 

3. If desired, enter a new protocol name and description in the appropriate fields. 

4. Enter a new version number in the Version field. 

5. Edit the manufacturer if needed. 

6. Edit the Acquisition Settings and Analysis Settings as necessary. 

7. Click Next to display the Analytes subtab. 

8. From the Analytes subtab, click an analyte's Analysis field to open the Analysis Settings dialog box. 

a. Choose Luminex Qualitative or No Analysis from the Method drop-down menu. 

NOTE: If you want an analyte to be an Intra-Well Normalization Bead, select Mark as Intra-Well 

Normalization Bead. The normalization bead is a microsphere set that is included in the assay as 

an internal control. It controls for sample variation and can be used to normalize data between 

samples in a run. Click OK or continue with the steps. 

b. Choose Lum Qual, Adv Qual, or another saved formula, from the Formulas drop-down menu. 

c. Click New Formula to add a new formula. 

i. Edit the name in the Formula Name field. 

ii. If you chose Lum Qual in the Formulas drop-down menu, edit the values for each range 

under Negative, Low Positive, and/or High Positive. If you chose Adv Qual in the 

Formulas drop-down menu, edit Negative, Low Positive, Moderate Positive, and/or 

Strong Positive. 

iii. Select the check box in the Inclusive columns to include the value in the range. If you clear 

the check box, the value will be one unit higher than the low value, and one unit lower than 

the high value. 

iv. Click Add Range if you want to add a new range. 

v. Enter a Range Name, Low Value, High Value, and select or clear the Inclusive check 

boxes. 

d. If you want to delete a range, highlight the range, and click Delete Range. 

e. Click Save Formula. The new formula displays in the Formulas drop-down menu. 

f. Click Apply to All Analytes to apply the settings to all of the analytes in the protocol, or click OK to 

apply the new formula to the single analyte you selected. 

9. Click Next. The Plate Layout subtab displays. 

10. Assign commands and routines to the plate layout. 

11. Click Save. 
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Import a Protocol 

1. Navigate to the Protocols page > Protocols tab. 

2. Click Import. 

3. In the Open dialog box, choose a protocol file (.lxt2) to import, then click Open. 

4. In the Imported Protocol File dialog box, click OK. The imported protocol displays in the Installed 

Protocols section. 

Export a Protocol 

1. Navigate to the Protocols page > Protocols tab. 

2. Choose a protocol. 

3. Click Export. 

4. In the Save As dialog box, choose a location to export the file to, and click Save. 

5. In the Export File dialog box, click OK. 

Delete a Protocol 

1. Navigate to the Protocols page > Protocols tab. 

2. Choose a protocol. 

3. Click Delete. 

4. In the Delete Protocol dialog box, click Yes. 
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Define the Standards and Controls 

Standards and Controls 

Assay kits may include standards and/or controls. After you enter the assay kit information, it can be used in 

multiple protocols. For assay reagents specified in protocols, you can create new lots, edit lot information, select 

pre-existing lots for reuse, import lots, and export lots. 

On the Stds & Ctrls tab in the Installed Kits And Lots section, before deleting, exporting, importing, or editing a 

kit and/or lot, select the correct radio button for Std/Ctrl Kits Only or All Lots. Selecting All Lots will display all 

standard and control reagents and any associated Std/Ctrl Kit. 

Once a lot is used, changing or modifying the lot will prompt you for a new lot or name. 

Create a Standard/Control Kit 

To create a standard and control kit, you must use a protocol that uses either Quantitative or Qualitative analysis 

set- tings; complete the following: 

1. Navigate to the Protocols page > Protocols tab. 

2. Select the protocol that you want to use for the kit, then click New Std/Ctrl. The Std/Ctrl Details subtab 

displays. 

3. Enter the name of the kit in the Name field, the lot number in the Std/Ctrl Kit Lot # field, the expiration 

date using MM/DD/YY format in the Expiration field, and the manufacturer in the Manufacturer field. 

4. Click Apply Std Lot if you want to apply a standard lot. The Select Lot dialog box displays. 

a. Choose a lot and click OK. 

5. Click Apply Ctrl Lot to apply a control lot. The Select Lot dialog box displays. 

a. Choose a lot and click OK. 

6. Alternatively, enter the appropriate information in the Assay Standard Information and Assay Control 

Information sections. The number of standards, controls, or both in these sections is defined in the 

protocol. If your batch uses controls, enter values for Expected, Low and High from the Show 

Concentration options. To apply the same values to multiple analytes, use the Apply Values arrows to 

apply values down or across the range of analytes. 

7. Click Save. 
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Create a Standard/Control Lot 

To create a standard and control lot, you must use a protocol that uses either Quantitative or Qualitative analysis 

settings; complete the following: 

1. Navigate to the Protocols page > Stds & Ctrls tab > click Create New Std/Ctrl Lots. 

a. In the Select Protocol dialog box, choose the protocol you want to use for this lot, then click OK. 

The Std/Ctrl Details subtab displays. 

b. Click Apply Std Lot if you want to apply a standard lot. The Select Lot dialog box displays. 

i. Choose a lot and click OK. 

c. Click Apply Ctrl Lot to apply a control lot. The Select Lot dialog box displays. 

i. Choose a lot and click OK. 

2. Enter the appropriate information for each standard in the Assay Standard Information section. 

3. In each analyte column, enter the expected concentration for the analyte. To apply the same values to 

multiple analytes, use the Apply Values arrows to apply values down or across the range of analytes. 

4. To apply a dilution, choose the value or create a dilution, then click Apply Dilution. 

NOTE: The Dilution list and Apply Dilution button only display if a quantitative analysis has been selected. 

5. If your batch uses controls, enter the appropriate information for each control in the Assay Control 

Information section. 

6. Enter values for Expected, Low, and High from the Show Concentration options. To apply the same 

values to multiple analytes, use the Apply Values arrows to apply values down or across the range of 

analytes. 

7. Click Save. 

Import a Kit/Lot 

1. Navigate to the Protocols page > Stds & Ctrls tab > click Import. 

2. In the Open dialog box, navigate to the location that you want to import from and click Open. 

Edit a Kit/Lot 

1. Navigate to the Protocols page > Stds & Ctrls tab. 

2. In the Installed Kits And Lots section, choose a kit or lot and then click Edit. 

3. If you chose a kit, edit the information as appropriate on the Std/Ctrl Details subtab. 

NOTE: If you choose to edit a standard lot, then only the Assay Standard Information section is editable. If 

you choose to edit a control lot, then only the Assay Control Information is editable. 

a. To apply the standard lot and control lot to a kit, enter the name of the kit in the Name field, and 

click Apply Std/Ctrl Kit. 

NOTE: The chosen kit must be associated with the same analyte names. 

b. Click Apply Std Lot. Select a lot from the list and click OK. 

c. Apply values across or down the Reagent, Name, Lot #, Expiration, and Analyte fields by double-

clicking the fields to enter a value, and then using one of the two Apply Values arrows to apply that 

value down or across the list of analytes. 

NOTE: The Dilution list and Apply Dilution button only appear if a quantitative analysis has been 

selected. 
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d. Click Apply Ctrl Lot. Select a lot from the list and click OK. 

e. Apply values across or down the Reagent, Name, Lot #, Expiration, and Analyte fields by double-

clicking the fields to enter a value, and then use one of the two Apply Values arrows to apply that 

value down or across the list of analytes. 

4. Click Save. 

Export a Kit/Lot 

NOTE: Lots and kits can only be exported if the protocol they were originally created with exists within the 

system. If the protocol has been deleted, the lot or kit cannot be exported. 

1. Navigate to the Protocols page > Stds & Ctrls tab. 

2. In the Installed Kits And Lots section, choose the kit or lot you want to export, then click Export. 

3. In the Save As dialog box, navigate to the location you want to export the file to, then click Save. 

Delete a Kit/Lot 

1. Navigate to the Protocols page > Stds & Ctrls tab. 

2. In the Installed Kits And Lots section, choose the kit or lot you want to delete, then click Delete. 

3. Click Yes in either the Delete Std/Ctrl Kit(s) Confirmation or Delete Lot(s) Confirmation dialog box. 

Invalidate Standards and Controls 

NOTE: It is possible to invalidate or remove a control in data analysis. However, Luminex does not recommend 

invalidating controls. 

For information on assay controls and guidelines for accepting or rejecting control values, contact the assay kit 

manufacturer. 

To invalidate standards, controls, and samples: 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the completed batch, then click Open. 

3. In the Results section on the Results subtab, click the square area to the left of the well you want to 

invalidate and click Invalidate. The whole row turns red. Or click the analyte results in a well and click 

Invalidate. 

NOTE: Select the same item and click Validate to remove the invalidation status. 

4. After Invalidate is clicked, an Analyze option will appear. Click Analyze.  

Validate Standards 

Your xPONENT® system administrator must give you privileges to validate standards if you are using the Secure 

xPONENT® package. All standards are assumed to be valid unless explicitly invalidated. 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the completed batch, then click Open. 

3. In the Results section, click the square area to left of the well you want to validate and click Validate. 

NOTE: Average rows or cells cannot be selected. If you have not selected an item or the item you 



 

48 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

selected does not need to be validated, a warning dialog box displays. 

 

 

Define the Samples 

Create a New Sample List 

NOTE: Creating a new sample list is intended for Laboratory Information System (LIS) users. If you are not using 

an LIS, you may want to import a sample list when creating the batch or editing the protocol. 

1. Navigate to the Samples page > Samples tab. 

2. In the Sample Lists section, choose the protocol you are using for the sample list, then click Create New 

Samples. 

3. Add the following information for your sample in the Create Sample subtab: 

a. Enter the sample ID in the ID field. 

NOTE: Sample IDs are limited to 30 characters. 

b. Enter a sample first name in the First Name field (optional). 

c. Enter a sample last name in the Last Name field (optional). 

d. Enter a comment in the Comment field (optional). 

e. Click Save to add the sample to the Sample list. 

4. Click New to create more samples or Edit to edit the sample. 

5. Click Close after you add your samples. 

NOTE: Samples can also be added using an LIS. 

Edit a Sample List 

1. Navigate to the Samples page > Samples tab. 

2. In the Sample Lists section, choose the protocol you want to edit, then click Details. 

3. Choose a sample in the Edit Samples subtab, then use the Move arrows to move the sample up or down 

in the sample list, changing the order in which the samples will be acquired. 

4. Click Edit. 

5. Edit the appropriate fields or click Undo to undo any changes. 

6. Click Save when you are done editing the sample. 

7. Click Close when you have completed editing the sample. 

 

 

Define the Batch 

Create a New Batch from an Existing Protocol 

When running a kit with a provided protocol, the protocol for the assay must be run as instructed in the assay's 
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package insert. 

1. Navigate to the Batches page > Batches tab > click Create a New Batch from an existing Protocol. 

2. Enter the batch name in the Batch Name field. 

3. Enter a description about the batch in the Enter Optional Description field. 

4. Choose a protocol in the Select a Protocol list. 

5. Click Next. If the protocol uses standards, controls, or both, the Stds & Ctrls subtab displays the details of 

the active reagents. Click Next. If the chosen protocol does not use standards or controls, the Plate 

Layout subtab displays. 

6. Assign standards, controls, samples, or well commands for this batch on the Plate Layout subtab. 

a. If you need to define a replicate count, choose the Replicate Count before adding a well command. 

i. Choose the Grouping - 123123123 OR 111222333 - to define how the replicate count is 

laid out in the plate wells. Grouping selection must be made before adding a well command. 

b. In the plate image, click and drag to highlight a series of wells, click a column or row header to 

highlight the entire column or row, or click and highlight different wells and then click a command to 

assign that command to the highlighted wells. Each command is associated with a color. 

i. Before adding well commands, delete all standards from the plate layout if any of the 

standards need to be rearranged. Delete all controls from the plate layout if any of the 

controls need to be rearranged. 

ii. If you need to change the acquisition order of a command in the plate, select the command 

in the Command Sequence list, and click the Move Command arrows, up or down. 

iii. To begin acquisition at a well other than A1, select the well you want to begin acquisition, 

and click Start at Well. 

c. Select a well and then choose Add, Delete, Pre-Batch Routine, or Post-Batch Routine, as 

applicable. 

NOTE: Wells and commands you assign to the protocol plate layout are saved into the protocol 

settings and execute each time you use the protocol to run a batch. Standards and controls 

associated with a given protocol typically remain constant, while the number of unknown wells often 

varies. You can assign a specific number of unknown wells to the plate when setting up a batch. 

NOTE: If you need to add multiple plates to the batch, click Add Plate to add another plate. 

7. Specify the direction to run the plate commands by selecting either vertically or horizontally. The selected 

direction also dictates how wells are added to the plate when assigning multiple unknowns, standards, and 

controls at one time. 

8. Click Run Batch to begin batch acquisition, or click Save to save batch information to the Pending Batch 

list to be run at a later time. 

a. If the batch spans more than one plate, the tray ejects automatically when all defined wells have 

been acquired. A dialog box displays, prompting you to insert the next plate. 

Create a Multi-Batch 

The Multi-batch feature automatically sets the batches side-by-side if space remains on the plate. Ensure that the 

batches fit on one plate. If space limitations create an overlap, an error message displays. Results for each batch 

are saved as individual batch files. Batches must be created first, before they can be combined on one plate to 

create a multi-batch. 

NOTE: There is a limit of 96 batches in a multi-batch. 
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NOTE: You cannot add a batch that forces multiple plates to a multi-batch operation. All batches must use the 

same plate name previously defined and adjusted. 

1. Navigate to the Batches page > Batches tab > click Create a New Multi-Batch. The New Multi-Batch 

subtab displays. 

a. If the Select Pending Batch dialog box displays, choose the batch you want to add to the new 

multi-batch list. 

b. Click OK. 

2. Click Add to add a batch. The Select Pending Batch dialog box displays. 

3. Choose a batch from the available options, including batches newly created. 

4. Click OK. The selected batch will then display on the plate layout. 

NOTE: After you add each batch, the software automatically adds the next batch to the first well of the 

next column or row (depending on the plate direction). You can also select a well first, which places the 

next batch in your chosen location. 

NOTE: If the batches chosen do not fit on the plate, a Multi-Batch Error dialog box opens, indicating you 

must edit one or more of the selected batches. 

Save a Multi-Batch 

After creating a multi-batch, save it to the Pending Batches list. When saved to this list, the protocol appears as 

Multi-Batch. 

1. Navigate to the Batches page > Batches tab. 

2. Choose a pending multi-batch and click Edit. The New Multi-Batch subtab displays. 

3. Enter the name for the multi-batch in the Multi-Batch Name field. 

4. Click Save. The multi-batch is now added to the pending batches list. 

Edit a Batch 

1. Navigate to the Batches page > Batches tab. 

2. In the Pending Batches list, choose the batch you want to edit, then click Edit. The Protocol subtab 

displays. 

3. Enter a new Batch Name and Description if needed. 

4. Choose a protocol and click Next. 

5. Edit the information as needed on the Stds & Ctrls and Plate Layout subtabs. On the Plate Layout 

subtab, confirm that the plate layout conforms to your specific assay instructions. 

6. Click Save on the Plate Layout subtab. 

NOTE: Batches saved to a multi-batch cannot be edited unless they are removed from the multi-batch.  

NOTE: Only run a batch from the Batches page > Batches tab. 

Import a Batch 

You only need to import batches to the system once. Enter the lot information for the standard and control 

reagents as specified in the protocol. This lot information is used for every batch set up using the protocol, until it 

is changed. 
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1. Navigate to the Batches page > Batches tab > click Import. The Import Batch dialog box displays. 

NOTE: Batch files are MDF files. The MDF file allows importing batch data from one xPONENT® to 

another. 

2. Click Browse. The Select File dialog box displays. 

3. Navigate to the batch file you want to import, then click Open. 

4. Click OK. The batch displays in the Pending Batches list. 

Export a Batch 

1. Navigate to the Batches page > Batches tab. 

2. In the Pending Batches list, choose the batch you want to export, then click Export. The Export Batch 

dialog box displays. 

NOTE: You can export batches, but not multi-batches. 

3. Click Browse. The Select File dialog box displays. 

4. Navigate to the location where you want to save the file, then click Save. 

NOTE: If you plan to replay this batch in the future, be sure to include the raw (.lxb) files. 

5. In the Export Batch dialog box, select Overwrite to overwrite the previous file that you may have 

exported. 

6. In the Export Batch dialog box, click OK. 

NOTE: When exporting a large batch and including the LXB files, the export process may take 10 minutes 

or more. 

7. When the export is complete, click OK in the Export Batch File dialog box. 

Delete a Batch 

You can only delete unprocessed batches. Batches are deleted from the Open Batch list and moved to the Open 

Incomplete Batch list. 

1. Navigate to the Batches page > Batches tab. 

2. In the Pending Batches list, choose the batch you want to delete, then click Delete. 

3. Click Yes in the Delete Pending Batch dialog box. 

NOTE: Batches saved to a multi-batch cannot deleted unless they are removed from the multi-batch. To 

remove a batch from a multi-batch, click a well in the plate layout, then click Remove. 

NOTE: You can remove a batch that includes results only through the Archive Utility. 

Run a Pending Batch 

1. Navigate to the Batches page > Batches tab. 

2. Choose the pending batch that you want to run, then click Run. 

NOTE: If the batch spans more than one plate, the instrument automatically ejects the first plate after 

acquiring all of the wells. Insert the next plate when the dialog box prompts you to. 
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Run the Post-Batch Routine 

A Luminex Post-Batch routine automatically runs at the end of each batch to clean the sample chamber and 

maintain peak system performance. This cannot be deleted or modified and runs by default. However, you can 

turn off this routine or use a different routine. 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. From the Routine Name drop-down menu, choose Post-Batch Routine (Luminex). 

3. Choose the Plate Name from the drop-down menu. 

4. Click Eject. 

5. Add the reagents – distilled water, 70% isopropanol or 70% ethanol, and sodium hydroxide (0.1N NaOH). 

6. Click Retract. 

7. Click Run. 



 

53 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Chapter 7: Analyzing the Results 

View the Results 

1. Navigate to the Results page > Current Batch tab. 

2. On the Current Batch tab you can view results, statistics, and log information related to the current batch, 

and per- form statistical analysis on the batch results. 

View Sample Details 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the desired batch from the Completed Batches list and click Open. 

3. Click the Sample Details subtab. 

4. If you are using an Laboratory Information System (LIS)-licensed package of the software, click Transmit 

to transmit sample details to the LIS database. You can transmit either a single analyte per sample or the 

entire sample. 

View Batch Settings 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the desired batch from the Completed Batches list and click Open. 

3. Click the Settings subtab, click the left and right Page arrows to view the pages of the batch settings 

report. 

4. If desired, click Save to open the Save As dialog box. 

5. Navigate to the location where you want to save the batch settings report, and click Save. 

6. In the Report Save Success dialog box, click OK. 

View Batch Logs 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the desired batch from the Completed Batches list and click Open. 

3. Click Log on the Results tab to open the Log subtab. 

 

 

Generate Reports 

1. Navigate to the Results page > Reports tab. 

2. From the Report drop-down menu, choose the category of report: Batch, Protocol, Calibration and 
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Verification, Performance Verification, System Log, or Advanced. Depending on what you choose in the 

Report list, the content of the Type list changes and other features will display in the window. 

3. From the Type drop-down menu, choose the specific report type. 

a. If you chose either a Batch report or a Protocol report, select the specific batch or protocol from the 

list. 

b. If the report you chose requires a date range (Calibration and Verification, Performance Verification, 

and System Log), use the calendars available to establish the date range. 

4. Batch reports require a choice of analytes; select them from the Select Analytes section. Select them all 

using the All button; clear your selections using the Clear button. 

5. Click Generate. If the report includes multiple analytes, use the arrows above the report to move through 

the list of analytes. 

6. Use the Zoom drop-down menu to increase the size of the report. 

 

 

Export the Batch Results 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the completed batch to export and click Exp Results. 

3. In the Save As dialog box, choose an export destination for the .csv file containing your results. 

NOTE: The CSV files are the only human readable files. These files can be opened with Excel or similar 

program to analyze/view data. 

4. Click Save. 

5. In the Export Complete dialog box, click OK. 

 

 

Transmit Results to the LIS 

Only approved batches can be transmitted to the Laboratory Information System (LIS). If your software is licensed 

for LIS use, you can transmit batches to the LIS from the Saved Batches tab. 

1. Navigate to the Results page > LIS Results tab. 

2. Select a single analyte or the entire sample. 

3. Click Transmit to send the results to the LIS. 

 

 

Reacquire Wells from a Batch 

Reacquire is performed at the end of a run if a well needs to be reanalyzed. xPONENT® creates a copy of the 

original file (this new file contains the reacquired values). 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the completed batch from the Completed Batches table. 
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3. Click Reacquire. 

4. Select the Reacquire check box for the desired well(s) on the Results subtab. 

5. Click Run to have the instrument reanalyze the well(s) selected. 

6. Click Yes on the Save Copy of Original Batch dialog box. You also have the option to change the file 

name. 

 

 

Replay a Batch 

Replaying a batch uses the raw bead data files from the initial acquisition to reanalyze the batch, and creates a 

new batch output file. The bead data files are replayed using the analyte, analysis settings, and plate layout 

selected in the new batch or protocol. Settings such as Bead Type, Volume, and XY Heater have no effect. 

Results from replaying a batch are generated with new .lxb and .csv files. 

Replaying a large batch can take one hour or more to complete. Allow adequate time for the operation to 

complete; batch replay cannot be stopped while in progress. The operation is complete when all progress bars 

have disappeared. 

A batch can be reanalyzed multiple times. When you replay or recalculate a batch, you perform the same steps to 

create the batch as you did when you created the batch the first time. The initial batch data and output file always 

remain intact and unchanged. Each time you replay a batch, the system handles it as if it is new data, and creates 

a separate batch entry and output file. 

If you choose to replay a batch that was originally run without a saved protocol, you have to modify the settings. 

After you have modified the settings, click Replay Batch on the Plate Layout subtab to perform the replay or 

recalculate procedure. 

If the system crashes but the plate finished, the data can be recovered by replaying the batch. 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the batch to replay in the Completed Batches section, and click Replay. This opens the Select 

Replay Mode dialog box. By default, Recalculate data is selected, select Replay Batch. Click OK. 

NOTE: When replaying data, if there is a saved protocol associated with the batch, the Protocols subtab 

will dis- play. Select the preferred protocol to replay batch MFI values. If an amended or new protocol is 

needed, create the protocol before replaying the batch data. If there is not a protocol associated with the 

data, the Settings subtab will display to create a protocol. Analysis settings and plate layout are required 

by xPONENT® to replay batch MFI values. 

NOTE: After you have approved a batch, the status of the batch changes to Approved in the Completed 

Batches list. 

3. Enter a batch name and description on the Settings subtab.  

NOTE: You cannot edit the Acquisitions Settings. 

4. Edit the Analysis Settings section as needed to create a new protocol. 

5. Click Next. 

6. Edit the necessary information on the Analytes subtab. 

7. Click Next. 

8. Edit the necessary information on the Stds & Ctrls subtab. 

9. Click Next. 
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10. Edit the necessary information on the Plate Layout subtab. 

a. Choose the wells you wish to replay on the Plate Layout subtab. Only wells previously read will be 

available to replay. 

11. Click Replay Batch. 

12. Click OK once the batch is complete. 

 

 

Recalculate Batch Data 

Recalculating data reanalyzes the batch results using only the batch’s MFI values. 

The batch MFI values will be recalculated using the analysis settings and plate layout selected in the new 

recalculated batch or protocol. Settings such as Volume, Timeout, and XY Heater have no effect. Because only 

the MFI values are reanalyzed, no data will be displayed in the dot plot. Recalculating data from a large batch can 

take one hour or more to complete. 

1. Navigate to the Results page > Saved Batches tab. 

2. Choose the data to recalculate in the Completed Batches section, and click Replay. 

3. Ensure Recalculate data is selected in the Select Replay Mode dialog box and click OK. 

NOTE: When recalculating data, if there is a saved protocol associated with the batch, the Protocols 

subtab will dis- play. Select the preferred protocol to recalculate batch MFI values. If an amended or new 

protocol is needed, create the protocol before recalculating the batch data. If there is not a protocol 

associated with the data, the Settings subtab will display to create a protocol. Analysis settings and plate 

layout are required by xPONENT® to recalculate batch MFI values. 

4. Enter a name and description for the batch. 

5. Choose a protocol with the data you want to recalculate from the Select a Protocol section. 

6. Click Next. 

7. Edit the necessary information on the Stds & Ctrls subtab. 

8. Next. 

9. Edit the necessary information on the Plate Layout subtab. 

a. Choose the wells you wish to recalculate on the Plate Layout subtab. Only wells previously read will 

be available to replay. 

10. Click Replay Batch. 
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Chapter 8: Troubleshooting 

Troubleshooting procedures help users isolate, identify, and remedy problems with the system. This chapter does 

not troubleshoot problems with the PC. For help with PC problems, please contact the technical support system 

for your PC’s manufacturer. 

 

 

Generate and Send the Support Utility File 

The Support Utility tab creates a support file that you can send to Technical Support. The file also contains 

calibration and verification reports. 

NOTE: Ensure the instrument is powered on and connect to xPONENT® before generating a Support Utility File. 

1. Navigate to the Maintenance page > Support Utility tab. 

2. Choose the batch you want to generate a support utility file for, and then select the Include Batch 

Information check box to include the batch information with the support file. 

3. Click Support to launch the Support Utility dialog box. 

4. Enter your name in the Name field. 

5. Enter your company name in the Company Name field. 

6. Enter your phone number in the Phone Number field. 

7. Enter your email in the Email field. 

8. In the Comment field, type a detailed description of the problem you are experiencing. 

9. In the Directory Configuration section, verify the location where you want to store the file in the Output 

Directory field. 

a. To change the location, click Browse, then navigate to the new folder and click OK. 

10. Click Save File. The saved file includes date and time information. 

11. In the Save As dialog box, enter the file name and then click Save. 

12. Send an email to support@luminexcorp.com and attach the support file (xPONENTSupportFile.zip) to the 

email.  

NOTE: You can save and/or print the report, if desired. 

 

 

Calibration/Performance Verification Failures 

Calibration Failure 

Calibration problems can result from a variety of causes, many of them easily correctable human errors. 

mailto:support@luminexcorp.com
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Table 1. Calibration Failure 

Problem Corrective Action 

Possible Calibration Microsphere Causes: 

The calibration microspheres are not fully resus- 

pended. 

Vortex the calibration vials to resuspend the 

microspheres. 

The wrong lot number or target values were 

entered in the software. 

Correct the lot number and target values in the 

software. 

The calibration microspheres are in the wrong well. Change the well setting in the software. 

There are not enough calibration microspheres in 

the well. 

Add at least five drops of calibration micro- 

spheres to the well. For accurate drop volume, 

hold the vial upside down at a 90 degree angle 

to the plate while dispensing them. 

You are using the incorrect calibration 

microspheres. 
Use the xMAP® MAGPIX® Calibration Kit. 

The calibration microsphere lot is expired. 
Substitute an unexpired bottle of calibrator 

microspheres. 

Possible Sample Probe Causes: 

The sample probe height is incorrect. 
Perform an automatic sample probe height 

adjustment. 

The sample probe is clogged. Refer to topic Troubleshooting > Clogs. 

The probe fitting is loose. Tighten the probe fitting. 

Other Possible Causes: 

There is a partial clog in the instrument. Refer to topic Troubleshooting > Clogs. 

There is air in the instrument. 

Perform an automatic sample probe height 

adjustment. Use the software to run a prime 

command three times, an alcohol flush 

command twice, 

then a wash command three times with 

distilled water. 

Make sure the drive fluid coil is not pinched. 
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Problem Corrective Action 

The sample valve is faulty. Contact Luminex Technical Support. 

There is a problem internal to the instrument. 

Review the log of calibration reports. Check for 

dramatic changes in temperature or voltage. If 

any of these are present, contact Luminex 

Technical Support. 

No events are being collected during calibration. 

Check the drive and waste fluid levels. Verify 

that tubing for both bottles is tightly connected 

to the instrument. Check that the waste bottle 

cap is vented. 

Check for sample probe problems. 

Performance Verification Failures 

Verification problems can have a variety of causes, many of them easily correctable human errors. 

Table 2. Performance Verification Failures 

Possible Causes Corrective Action 

Possible Verification Microsphere Causes: 

The verification microspheres are not fully 

suspended 

Vortex the verification vials to resuspend the 

microspheres. 

The wrong lot number or target values were 

entered in the software. 

Correct the lot number and target values in the 

software. 

The instrument verification microspheres are in 

the wrong well. 
Change the well setting in the software. 

There are not enough verification microspheres in 

the well. 

Add at least five drops of verification 

microspheres to the well. For accurate drop 

volume, hold the vial upside down at a 90 

degree angle to the plate while dispensing them. 

You are using the incorrect verification 

microspheres. 
Verify that you are using the MAGPIX® 

Performance Verification Kit. 

The verification lot is expired. 
Use an unexpired bottle of verification micro- 

spheres. 

The verification microspheres have been diluted. Substitute undiluted verification microspheres. 
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Possible Causes Corrective Action 

The verification microspheres are photobleached. 

Use a different bottle of verification micro- 

spheres, one that has been protected from light 

during storage. 

Possible Sample Probe Causes: 

The sample probe height is incorrect. 
Perform an automatic sample probe height 

adjustment. 

The sample probe is clogged. Refer to topic Troubleshooting > Clogs. 

The sample valve is faulty. Contact Luminex Technical Support. 

Other Possible Causes: 

There is carryover from the calibrators or the 

previous assay. 

Refer to topic Troubleshooting > Carryover 

Problems. 

Air is in the instrument. 

Verify the sample probe height. Run three Prime 

commands, two Alcohol Flush commands, and 

three Wash commands with distilled water. 

Make sure the drive fluid coil is not pinched. 

There is a problem internal to the instrument. 

Review the log of calibration reports. Check for 

dramatic changes in temperature or voltage. If 

any of these are present, contact Luminex 

Technical Support. 

The waste line was moved during instrument 

operation, resulting in an unstable flow rate. 

Stabilize the waste line during instrument 

operation. 

Carryover Calibration Problems 

Carryover from calibration can interfere with verification; likewise, carryover from an assay can interfere with 

correct reading of the following assay. Take the following steps to eliminate carryover: 

• Begin by performing four rinse cycles. 

• If that fails, run the Clean command twice using a sodium hydroxide solution (0.1N NaOH). 

• If running the Clean command twice fails, run the Enhanced Startup Routine. 
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Instrument Errors 

Communication Problems 

Communication problems described in this section involve the links between the data system (PC and software) 

and MAGPIX®. 

The term “Communication” refers to: 

• The transfer of data between the PC and the MAGPIX. 

• The current status of the MAGPIX. 

• Instrument control, sample acquisition, session uploading, and start, stop and pause features. 

Table 3. Communication Problems 

Problem Possible Causes Corrective Action 

The PC cannot 

establish a connection 

with MAGPIX. 

The communication cable is unplugged or 

plugged into the wrong port. 

Plug in or move the communications 

cable. 

The MAGPIX is not turned on. 
Turn off the PC. Turn on the 

MAGPIX and then turn on the PC. 

Power Supply Problems 

Power supply problems often involve a blown fuse, faulty electronic component, or disconnected cable. 

 

Whenever you deal with a potential electrical problem, be careful to avoid electrical shocks. 

Table 4. Power Supply Problems 

Problem Possible Cause Corrective Action 

MAGPIX® will 

not turn on. 

The power cord is disconnected Plug in the power cord. 

The hard power switch on the 

back of the instrument is not 

turned on. 

Turn on the switch. 

No voltage is coming from the 

electrical outlet. 

Change to a different outlet. If MAGPIX is plugged into 
a surge protector, make certain the surge protector is 
turned on.  

The power supply is faulty. Contact Luminex Technical Support 
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Problem Possible Cause Corrective Action 

A fuse has burned out. Replace the fuse. 

Fuses 

continue to 

open (blow). 

A component has a short circuit. Contact Luminex Technical Support. 

Fluid Leaks 

There are numerous places in MAGPIX® where fluid can leak. Most leaks can be easily fixed; for the remainder, 

contact Luminex Technical Support. 

Table 5. Fluid Leaks 

Problem Possible Cause Corrective Action 

Fluid is pooled around 

the MAGPIX. 

Fittings, fluid tubes, or com- 

ponents are damaged, loose, 

or faulty. 

Turn off and disconnect the instrument to avoid 

electrical shock. Check for possible sources of 

leaking and correct them. if leaking continues, 

contact Luminex Technical Support. 

Fluid leaks within the instrument: 

A fluid tube leaks. The tube is damaged. 
If it is the sample probe tube, replace it. 

Otherwise, contact Luminex Technical Support. 

The waste bottle leaks. 
The waste bottle fitting is 

loose. 
Reset the waste bottle fitting. 

The drive fluid filter 

leaks. 

The drive fluid filter fittings 

are loose. 
Hand-tighten the drive fluid filter fittings. 

The sample probe 

leaks. 

The sample probe is 

clogged. 
Refer to topic Troubleshooting > Clogs. 

The sample probe is loose. Tighten the fitting. 

The sample valve 

leaks. 

The sample valve has one or 

more loose fittings. 
Hand-tighten the sample valve fittings. 

The sample valve is faulty. Contact Luminex Technical Support. 

The syringe seal leaks. The seal is worn out or faulty. Replace the syringe seal or replace the syringe.  
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Problem Possible Cause Corrective Action 

The syringe valve 

leaks. 
The valve is loose or faulty. 

Hand-tighten the syringe connection (silver knob) 

on the syringe valve. Run a Prime command. If 

leaking continues, contact Luminex Technical 

Support. 

 

 

Low Bead Count 

Clogs 

Often, a clog somewhere in the MAGPIX® is the cause of a problem with calibration, verification, or data 

acquisition. To determine if there is a clog, run performance verification to see if the fluidics function is operating 

properly. In the event you encounter a problem that is clog-related, use the following procedure. 

To troubleshoot a possible clog: 

1. Clean and adjust the sample probe. 

2. Remove the clogs. 

3. Run calibration and verification. 

If this procedure is unsuccessful, contact Luminex Technical Support. 

Sample Probe Problems 

Problems with the sample probe can lead to fluid leaks acquisition failure. 

Table 6. Sample Probe Problems 

Problem Possible Cause Corrective Action 

The sample 

probe leaks. 

The sample probe is clogged. Refer to topic Troubleshooting > Clogs. 

The sample probe is loose. Tighten the fitting. 

The sample arm 

is stuck in the up 

or down 

position. 

The sample probe motor 

connections are loose. 

Contact Luminex Technical Support. Check 

pressure settings. 

The sample probe motor is faulty. Contact Luminex Technical Support. 

The sample arm 

does not go 

down smoothly. 

The plate is incorrectly seated. Adjust the plate. 

The plate is warped. Replace the plate. 
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Problem Possible Cause Corrective Action 

The sample probe is bent. 

Remove the sample probe from the instrument and 

roll it on a clean, flat surface. If a sample probe has 

been bent and rolled straight more than once, 

discard it and replace with a new sample probe. 

Adjust the sample probe height. 

Acquisition Failures 

Acquisition failure can result from many of the same causes as calibration and verification failure, in addition to 

sample and volume problems. 

Table 7. Acquisition Failures 

Problem Corrective Action 

Possible xMAP® Microsphere Causes: 

The xMAP microspheres are not 

fully suspended. 

Gently vortex the plate or resuspend microspheres with a multichannel 

pipette to ensure that the microspheres are present in the solution. 

The wrong lot number or target 

values are entered in software. 
Correct the lot number and target values in the software. 

The wrong wells are selected for 

the xMAP microspheres. 
Change the well setting in the software. 

The xMAP microspheres have 

expired. 
Substitute an unexpired bottle of xMAP microspheres. 

The xMAP microspheres are 

photobleached. 
Substitute xMAP microspheres that are not photobleached. 

Possible Sample Probe Causes:  

The sample probe height is 

incorrect. 
Perform an automatic sample probe height adjustment. 

The sample probe is clogged. Refer to topic Troubleshooting > Clogs. 

Other Possible Causes:  

The drive fluid or waste line is not 

fully connected. 
Disconnect and reconnect the lines. 
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Problem Corrective Action 

Air is present in the instrument. 

Verify the sample probe height. Use the software to run a prime 

command three times, an alcohol flush command twice, then a wash 

command three times with distilled water. 

Make sure the drive fluid coil is not pinched. 

The acquisition volume is set too 

high. 

Set the acquisition volume to at least 25 μL less than the actual 

volume in your wells. This enables the probe to acquire sample more 

efficiently with less chance of incorporating air in the sample. 

The sample is too concentrated. 
Dilute concentrated biological fluids, such as serum or plasma, at least 

1:5. 

Bead Detail Irregularities 

Use these tools to assist in diagnosing instrument and assay-related problems: 

• System calibrators 

• MAGPIX® performance verifiers 

• Assay standards 

• Assay controls 

• Error messages 

Review the log of calibration reports routinely to detect trends. 

Use MAGPIX performance verifiers to check the success of the instrument calibration and to troubleshoot. If there 

is a problem with assay results, MAGPIX performance verifiers can help determine if the problem is related to the 

instrument. If calibration and verification are successful, contact the assay manufacturer. 

The following table identifies the three possible categories of microsphere dot plots: normal, irregular due to 

photobleaching of the microspheres, and irregular due to MAGPIX being out of calibration. 

Table 8. Bead Details 

Appearance Description 
Possible 

Problem 
Solution 

Normal Bead Grouping 

 

 

MagPlex® verifiers form a tight bead 

population within the boundaries of the 

gray region. 

N/A  N/A 
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Appearance Description 
Possible 

Problem 
Solution 

Irregular Bead Grouping: Photobleached Microspheres  

 

MagPlex verifiers are outside of their 

region (below or to the left). 

MagPlex 

verifiers are 

photobleached. 

Reverify with new 

MagPlex verifiers. 

 

MagPlex verifiers are outside of their 

region (above or to the right). 

MagPlex 

calibrators are 

photobleached. 

Recalibrate with 

new MagPlex 

calibrators and 

verify. 

Other Irregular Bead Groupings 

 

The dot plot is elongated, horizontally or 

vertically, with microsphere scatter. 

Incompatible 

drive fluid or air 

in the system. 

Verify that the 

system is using 

MAGPIX Drive 

Fluid or MAGPIX 

Drive Fluid PLUS, 

and verify that it is 

clear and colorless. 

Check for tightness 

on accessible 

fittings. 
 

MagPlex microspheres fail to form a tight 

population within their regions. 

 

The dot plot is elongated, horizontally or 

vertically. 

Incompatible 

drive fluid. 

Verify that the 

system is using 

MAGPIX Drive 

Fluid or MAGPIX 

Drive Fluid PLUS, 

and verify that it is 

clear and colorless.  

MagPlex microspheres fail to form a tight 

population within their regions. 

 

MagPlex microspheres fail to form a tight 

population within their regions, and the 

dot plot extends diagonally. 

Incompatible 

solvents may 

be present in 

assay buffer. 

Contact Luminex 

Technical Support 

to request a list of 

incompatible 

solvents. If the 

solvent you are 

using is listed, 

switch solvents. 
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Run a Self Test 

Perform a Self Test to evaluate the hardware component of the system and all operations are functioning 

properly. 

If there is a failure you can try to cycle the power to correct the failure. If that does not fix the issue, then call 

Luminex Technical Support. 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Click Self Test. 

3. Click Run. 

 

 

Customer Orderable Part Numbers 

Table 9. Hardware Part Numbers 

Product Description Customer Number 

Access Door Tool CN-0264-01 

Fuse 2AMP 250V Fast Acting (Qty 1) CN-0019-01 

Sample Probe Needle CN-0221-01 

Heater Block, 96 Wellplate CN-0224-01 

Cable, USB (A to B) CN-0271-01 

Air Filter 4.5 x 4.5 CN-0257-01 

Drive Fluid Filter CN-0258-01 

Sample-to-Valve Tubing Assembly CN-0259-01 

Off-Plate Reagent Block CN-0260-01 

Waste Bottle Assembly CN-0261-01 

Syringe, 500 µL Ball End CN-0262-01 

Sample Probe Height Adjustment Kit CN-0263-01 
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Product Description Customer Number 

Barcode Scanner CN-PC03-01 

Cable, Power CN-PXXX-01* 

* XXX is a country specific part number. For more information, contact Luminex Technical Support.  

Table 10. Reagent Part Numbers 

Product Description Customer Number 

MAGPIX® Calibration Kit MPX-CAL-K25 

MAGPIX® Performance Verification Kit MPX-PVER-K25 

MAGPIX® Drive Fluid PLUS, 4PK 40-50030 
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Chapter 9: Maintaining the System 

To ensure accurate test results, properly clean and maintain the MAGPIX®. Read and follow all instructions in this 

chapter. To facilitate your maintenance process, print out and use the Maintenance Log. 

 

 

General Maintenance Precautions 

Observe the following general maintenance precautions. 

 

Personnel who use, maintain, or clean the MAGPIX® should be trained in standard laboratory 

safety practices and should follow those practices when handling the instrument. 

Samples and waste fluid can contain biohazardous material. Where exposure to 

biohazardous material, including in an aerosol form, exists, follow appropriate biosafety 

procedures, use personal protective equipment (PPE), and use ventilation devices. 

Avoid contact with moving parts. Disconnect the instrument from the power source when the 

procedure instructs you to do so. 

Do not remove the cover of MAGPIX. All maintenance can be performed from the outside of 

the instrument, within the fluid compartment, or within the compartment that is accessible by 

opening the side access door. 

 

 

Maintenance Commands and Routines 

Wash 

Sends 250 µL of distilled water through the chamber and fluidic lines in the system. It pulls 

the fluid from a well or reservoir and runs it completely through the system to the waste fluid 

container. 

Clean 

Aspirates a cleaning reagent such as a 0.6% sodium hypochlorite solution with no additives 

or sodium hydroxide. 

NOTE: The xPONENT® for MAGPIX® software may refer to a 0.6% sodium hypochlorite 

solution with no additives as ‘10% to 20% household bleach’. 

Alcohol Flush 
Removes air bubbles from the sample tubing and the cuvette using 70% isopropanol or 70% 

ethanol. The alcohol flush takes about 5 minutes. 
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Rinse 
Re-primes the probe and rinses out the chamber. No reagent is needed but one of the off-

plate reservoirs must be empty. 

Soak 

Perform the soak function at the end of each day. The system uses at least 200 µL of distilled 

water. Prevents salt crystals from forming in the sample probe due to air exposure. Soaking 

the sample probe replaces drive fluid in the sample probe with water. 

Sanitize 

Performs a similar function as the alcohol flush command, but uses a 0.6% sodium 

hypochlorite solution with no additives to decontaminate sample lines and the cuvette after 

biohazard contact. 

NOTE: The xPONENT® for MAGPIX® software may refer to a 0.6% sodium hypochlorite 

solution with no additives as ‘10% to 20% household bleach’. 

Prime 
Removes air bubbles from the system's fluidic pathways by drawing drive fluid from the drive 

fluid bottle. You do not need to supply solution in a plate. 

Self-Test 
Performs a self-diagnostic test to see if the system and all operations are functioning 

properly. The self-test evaluates the sample delivery and the optics module. 

VER Performs a verification. 

CAL Performs a calibration. 

Fluidics Runs fluidics. 

 

 

Create a New Maintenance Routine 

Create maintenance routines to facilitate your startup procedure, shutdown procedure, troubleshooting, or 

calibration. Ensure that the maintenance routine you create is consistent with the Luminex® instrument operations 

and maintenance requirements. 

To create a new maintenance routine: 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Choose None in the Routine Name drop-down menu. 

3. Choose the plate in the Plate Name list to use for the new routine. 

4. In the Commands section, click one or more commands to add to the routine. These commands display in 

the plate image and in the Command Sequence list. 

NOTE: When you choose the CAL command, a Rinse command is performed prior to the CAL. When the 

CAL is complete, two additional Rinse commands are performed. This prevents a bubble from loading into 

the chamber. Verify that you have sufficient room in the reservoir to complete these Rinse commands. 

NOTE: When you choose the VER command, a Rinse command is performed prior to the VER. When the 

VER is complete, an additional Rinse command is performed. This prevents a bubble from loading into the 

chamber. Verify that you have sufficient room in the reservoir to complete these Rinse commands. 

5. To change a location (well or reservoir) for a command, click the command in the Command Sequence 
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list, then click the new location in the plate image. 

NOTE: If you attempt to place two or more commands in the same well; a message displays instructing 

you to change the location of the command. Some commands can be run from the same location, for 

example, multiple washes can be run from the same reservoir. 

6. Click Save As to save the new routine. The Save Routine dialog box displays. 

7. Enter the routine name in the Routine Name field, then click OK. 

Run a Maintenance Routine 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Choose a routine from the Routine Name drop-down menu. 

3. Click Eject. 

4. Add the appropriate reagents to the plate, reservoirs, and strip wells, as indicated in the plate image and 

set the plate on the plate holder. 

5. Click Retract. 

6. Click Run. The Routine Message dialog box displays when the routine is complete. 

7. Click OK. 

Import a Maintenance Routine 

1. Navigate to the Maintenance page > Cmds & Routines tab > click Import. 

2. In the Open dialog box, browse for the file you want to import, then click Open. 

3. In the Import Routine File dialog box, click OK. The routine becomes the active routine. 

Edit a Maintenance Routine 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Choose a routine from the Routine Name drop-down menu. 

3. Click a command in the Command Sequence list that you want to edit. Click Clear to delete the 

command, or click in a different well in the plate image to change the location of that command. 

NOTE: When you add or remove a command, the routine name automatically defaults to None in the 

Routine Name drop-down menu. 

4. Add, delete, or change commands as necessary, then click Save As. 

NOTE: You can only add commands to the end of a routine. You cannot insert new commands before 

commands that are already part of a routine. 

5. Enter a different name for the routine to create a new routine, or type the existing name of the routine to 

keep the edited routine using the existing routine name. 

Delete a Maintenance Routine 

You can delete a routine that you created, but you cannot delete pre-defined routines. 

1. Navigate to the Maintenance page > Cmds & Routines tab. 



 

72 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

2. Choose a routine from the Routine Name drop-down menu. 

3. Click Delete. 

4. In the Delete Maintenance Routine Confirmation dialog box, click Yes to delete. 

Export a Maintenance Routine 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Choose a routine from the Routine Name drop-down menu. 

3. Click Export. 

4. In the Save As dialog box, navigate to the folder where you want to store the routine file, then click Save.  

NOTE: The export option is only available for routines that have been saved. 

5. In the Export Routine dialog box, click OK. 

 

 

Maintain Instrument Fluids 

MAGPIX® has a built-in compartment to hold a single-use disposable drive fluid bottle and a reusable waste fluid 

bottle. It comes with two waste fluid bottles and a two-pack of drive fluid bottles. All fluid tubing is contained within 

the instrument. 

NOTE: Do not refill or reuse the MAGPIX Drive Fluid or MAGPIX Drive Fluid PLUS bottles. 

Monitor fluid levels daily. Replace the empty drive fluid bottle as needed. If MAGPIX operates with an empty drive 

fluid bottle, the lack of drive fluid may interrupt a sample and prevent further samples from being collected. 

 

Only use MAGPIX Drive Fluid or MAGPIX Drive Fluid PLUS. Use of non-Luminex approved 

drive fluid shall constitute "Improper Use" and can void the warranty provided by Luminex 

and/or its authorized partner. 

Empty the waste fluid bottle whenever it is full. Use the following guidelines: 

• Replace the newly emptied waste fluid bottle with the second, dry waste fluid bottle so the moisture 

remaining in the first waste fluid bottle does not trigger a “waste bottle full” message. 

• Before removing the waste fluid bottle, make certain all other fittings and tubes are firmly attached to avoid 

any contamination from dripping waste fluid. 

Replace the Drive Fluid Bottle 

1. Open the door of the fluid compartment on the front of the MAGPIX®. 

2. Pull the drive fluid bottle out of the compartment and pull the plug out. 

3. Open the box of drive fluid bottles and remove one bottle. 

4. Insert the drive fluid bottle part of the way into the fluid compartment opening and remove the seal. 

5. Connect the drive fluid tube and plug to the opening on the top of the drive fluid bottle. 

6. Slide the bottle into the tray on the left side of the fluid compartment. The bottle tray is constructed to hold 

the bottle in place. 
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7. After the bottle is fully inserted, check the valve on the front of the waste fluid bottle to make certain it is 

securely attached and close the door of the fluid compartment. 

Empty the Waste Fluid Bottle 

Empty the waste fluid bottle, when the bottle is full. 

1. Open the door of the fluid compartment on the front of the MAGPIX®. 

2. Disconnect the orange waste fluid line from the waste fluid bottle by depressing the silver tab and pulling 

the fluid line out. 

3. Carefully remove the waste fluid bottle from its tray. 

4. Unscrew the cap on top of the waste fluid bottle to drain out the fluid. 

NOTE: Discard the waste fluid in accord with all local, state, federal, and country-specific biohazard 

handling regulations. 

5. Insert the second, dry waste fluid bottle in the fluid compartment. 

NOTE: Make sure the empty waste fluid bottle is dry or the empty bottle will continue to send a “Waste 

Bottle Full” message. 

6. Insert the orange waste fluid line into the waste fluid bottle opening by pushing the fluid line until it clicks 

into place. 

 

Waste fluid can contain biohazardous infectious agents. Where exposure to potentially 

biohazardous materials (including aerosol) exists, follow appropriate biosafety procedures 

and use personal protective equipment (PPE) such as gloves, gowns, laboratory coats, face 

shields (or mask and eye protection), respirators, and ventilation devices. 

 

 

Maintain Instrument Hardware 

Daily Maintenance 

Most of the daily maintenance tasks for MAGPIX® can be performed using available software commands. 

Run the Daily Shutdown Routine  

System shutdown is a standardized procedure in xPONENT® for MAGPIX® software. It includes sanitize, clean 

(with sodium hydroxide (0.1N NaOH)), wash, and soak routines. 

NOTE: The xPONENT for MAGPIX software may refer to a 0.6% sodium hypochlorite solution with no additives 

as ‘10% to 20% household bleach’. 

 

Sodium hydroxide is extremely caustic. If it comes into contact with skin, it can burn and 

cause tissue damage without causing pain. Always wear gloves and goggles when working 

with sodium hydroxide. 

Run the Daily Shutdown routine to prevent clogs and crystallization of salt in the sample probe. Clogs and 
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crystallization of salt in the sample probe can cause problems with calibration, verification, and data acquisition; 

they can also cause sample splashing. Shut down the system properly to ensure system integrity. 

1. From the Home page, click Shutdown. The Auto Maint tab displays. 

2. Click Eject. 

3. Fill reservoir RA1 3/4 full of DI water. 

4. Fill reservoir RC1 3/4 full of a 0.6% sodium hypochlorite solution with no additives. 

NOTE: Sodium hypochlorite solutions containing small amounts of sodium chloride (NaCl), sodium 

carbonate (Na2CO3), sodium hydroxide (NaOH), and other pH buffers may be used. Do not use sodium 

hypochlorite solutions containing film-forming agents, such as Diallyldimethylammonium Chloride 

(DADMAC), or other additives.   

5. Verify that reservoir RD1 is empty. 

6. Click Retract. 

7. Click Run. 

Shut Down the System 

 

Luminex does not recommend shutting down the MAGPIX® system while a run is in progress. 

Doing so may cause loss of data. 

NOTE: If the Daily Shutdown routine has not been run on the Home page > Auto Maint tab, run this routine before 

shutting down the system. 

1. Remove the plate and any bulk reagents from the instrument. 

2. Push the soft power switch on the front of the instrument. 

NOTE: The light in the hexagonal window will turn off as confirmation that the power is off. 

3. Perform a hard power shutdown by turning off the hard power switch located on the back of the instrument 

and unplug the instrument. 

4. Exit the xPONENT® software. 

5. Click Log Off, then click OK to confirm the logout. 

6. Click Exit, then click Yes to exit the software. 

7. Turn off the PC desktop. 

Weekly Maintenance 

Perform a Visual Inspection 

Inspect the MAGPIX® weekly. Make sure the instrument is idle, so there are no moving parts. Open the MAGPIX 

side access door and fluid compartment door. 

• Visually inspect for leaks, corrosion, and other signs of improper function. 

• Check all visible tubing connections. 
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Run the Clean Routine 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Click the Clean command. 

3. Click Eject. 

4. Fill reservoir Clean 3/4 full of sodium hydroxide (0.1N NaOH) in the of the off-plate reagent block. 

5. Click Retract. 

6. Click Run. 

Clean the Sample Probe 

 

Avoid contact with moving parts. If a plate is running, use the software to execute Stop to 

avoid the possibility of exposure to moving parts. The system must not be performing any 

operations while you carry out this maintenance procedure. 

To clean the sample probe: 

1. Click STOP if a plate is running. 

2. Turn off the MAGPIX® and unplug the power cord. 

3. Remove the sample probe. 

a. Open the side access door of the MAGPIX. 

i. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the 

door to the right. 

b. Lower the sample probe assembly. 

c. Unscrew the sample probe fitting on top of the probe completely. 

d. Grasp the sample probe gently and push up. 

e. Lift the sample probe out of the top of the sample probe holder. 
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1. Sample probe fitting (Unscrew and remove) 

2. Sample probe assembly 

3. Sample probe (Push up gently and lift out of holder) 

 

4. Clean the sample probe using a bath sonicator or a 10 mL syringe. If you are using a bath sonicator, place 

the tip of the sample probe in the bath sonicator for 2 to 5 minutes of water flowing through the probe 

syringe or place the sample probe in a clean tube containing water which will then be placed in a bath 

sonicator. If you are using a syringe, force deionized water through the tip of the sample probe and out the 

large end. This dislodges any debris clogging the tip. 

5. Replace the sample probe and tightly screw in the sample probe fitting until it clicks. 

6. Perform an automatic probe height adjustment. 

NOTE: Perform an automatic probe height adjustment any time the sample probe is reinstalled after 

removal. 

Remove Clogs 

 

Sodium hydroxide is extremely caustic. If it comes into contact with skin, it can burn and 

cause tissue damage without causing pain. Always wear gloves and goggles when working 

with sodium hydroxide. 

If you frequently use the MAGPIX® to test concentrated serum or other debris-ridden samples, Luminex 
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recommends that you perform a clog removal weekly. Otherwise, perform this procedure as needed. 

To remove clogs: 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. Click the Clean command. 

3. Click Eject. 

4. Fill reservoir Clean 3/4 full of sodium hydroxide (0.1N NaOH) in the of the off-plate reagent block. 

5. Click Retract. 

6. Click Run. 

Monthly Maintenance 

Clean the Exterior Surfaces 

NOTE: Sodium hypochlorite solutions containing small amounts of sodium chloride (NaCl), sodium carbonate 
(Na2CO3), sodium hydroxide (NaOH), and other pH buffers may be used. Do not use sodium hypochlorite 
solutions containing film-forming agents, such as Diallyldimethylammonium Chloride (DADMAC), or other 
additives.   

1. NOTE: The xPONENT® for MAGPIX® software may refer to a 0.6% sodium hypochlorite solution with no 

additives as ‘10% to 20% household bleach’.Turn off the MAGPIX® and unplug the power cord. 

2. Clean all exterior surfaces with mild detergent, followed by a 0.6% sodium hypochlorite solution with no 

additives, followed by distilled water. 

3. Open the side access door of the instrument. 

a. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to 

the right.  

4. Clean all accessible surfaces with detergent, followed by a 0.6% sodium hypochlorite solution with no 

additives, followed by distilled water. 

 

Avoid contact with the tubing and electronic parts of the instrument. 

5. Dry any unpainted metal surfaces to prevent corrosion and then close the side access door. 

6. Plug in the power cord and turn on the MAGPIX. 

Semi-Annual Maintenance 

Clean the Air Filters 

MAGPIX® has two air filters, one on the bottom of the instrument and one on the back of the instrument. Every six 

months, remove these air filters, clean them, and reinstall them. 

To clean MAGPIX air filters: 

1. Turn off MAGPIX and unplug the power cord. 

2. Slide the back filter up out of its holder. 

3. Lift MAGPIX and slide the bottom filter out of its holder toward the front of the instrument. 
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Before removing the bottom air filter, remove both the waste fluid and drive fluid bottles, the 

off-plate reagent block, and any plates in the instrument. 

4. Clean the filters with a vacuum or with distilled water. Stand the filters upright to air dry. 

 

Filters must be completely dry prior to re-installation. 

5. Locate the small incised arrow on the frame of the filter. This indicates air flow. The filter must be installed 

with the arrow pointing inward. 

 

6. Reinstall the filters. 

7. Plug in the power cord and turn on MAGPIX. 

 

 



 

79 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

 

 

1. Before Filter Removal 

2. After Filter Removal 

Replace the Syringe Seal 

When you replace a syringe seal, also replace the black O-ring that fits inside it. One package contains four of 

each. 

1. Turn off the MAGPIX® and unplug the power cord. 

 

The plunger guide does NOT deactivate while the seal is being changed; unplugging is 

necessary to avoid injury. 

2. Open the side access door of the MAGPIX. 

a. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to 

the right. 

3. Locate the syringe (glass cylinder with a metal rod plunger). 

4. Push the plunger guide down. The syringe may fill with clean drive fluid. 

NOTE: The plunger guide is tight. Be prepared to use some force to push it down. 

5. Unscrew the syringe from the top of its housing and carefully remove it. 

6. Pull the plunger out of the syringe and dispose of any drive fluid. 

7. Using a pair of pliers, remove the white plunger seal (at the top of the plunger) and discard it. 

8. Place the black O-ring inside the new white plunger seal and press the seal down on the top of the 

plunger. 

9. Return the plunger to the syringe. 

10. Screw the syringe back into its housing. 
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1. Syringe Housing 4. Glass Cylinder 

2. Metal Rod Plunger 5. Plunger Guide 

3. 
Syringe Seal (contains black O-

ring) 
  

11. Return the plunger guide to its original position. The bottom of the plunger fits into the indentation in the 

plunger guide. 

12. Plug in the power cord and turn on MAGPIX. 

13. Run two Prime commands, and watch for any leaks in the syringe area. 

14. Close the side access door. 

Replace the Syringe 

To replace the syringe: 

1. Turn off the MAGPIX® and unplug the power cord. 

 

The plunger guide does NOT deactivate while the seal is being changed; unplugging is 

necessary to avoid injury. 

2. Open the side access door of the MAGPIX. 

a. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to 

the right. 

3. Locate the syringe (glass cylinder with a metal rod plunger).  

4. Push the plunger guide down. The syringe may fill with clean drive fluid. 
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NOTE: The plunger guide is tight. Be prepared to use some force to push it down. 

5. Unscrew the syringe from the top of its housing and carefully remove it. 

6. Put the new syringe into place.  

7. Screw the syringe into its housing. 

 

1. Syringe Housing 3. Glass Cylinder 

2. Metal Rod Plunger 4. Plunger Guide 

8. Return the plunger guide to its original position. The bottom of the plunger fits into the indentation in the 

plunger guide. 

9. Plug in the power cord and turn on MAGPIX. 

10. Run two Prime commands, and watch for any leaks in the syringe area. 

11. Close the side access door. 
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Annual Maintenance 

Replace the Drive Fluid Filter 

To replace the drive fluid filter on MAGPIX®: 

1. Turn off MAGPIX and unplug the power cord. 

2. Open the side access door and locate the drive fluid filter at the left of the syringe pump. 

a. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to 

the right. 

3. Gently pull the filter from the mounting bracket. 

4. Unscrew the Top Tube Attachment and the Bottom Tube Attachment from the top and bottom of the 

filter. 

5. Ensure that the drive fluid filter orientation (top and bottom) matches the image and reattach the tubing to 

the ends of the new filter. Tighten both fittings until they click. 

 

 

1. Top Tube Attachment 3. Bottom Tube Attachment 

2. Filter 4. Mounting Bracket 

 

6. Press the new filter into the mounting bracket. 

7. Close the side access door. 

8. Plug in the power cord and turn on the MAGPIX. 

9. Use the software to run the prime command twice. Ensure that the drive fluid is being pulled into the 

syringe during the Prime. 
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Replace the Sample Probe Tube 

The tube that connects the sample probe to the valve is subject to wear because of the constant motion of the 

sample probe. Replace the sample probe tube on a yearly basis. 

Figure 15: Sample Probe Tube 

 

 

1. 
Sample probe tube (color-coded black at 

valve end) 

2. Valve 

3. ¼-28 flat-bottom fittings 

4. Strain relief 

5. Probe fitting 
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Figure 16: Sample Probe Tube Assembly 

 

 

1. ¼-28 Flat-bottom fitting 

2. Tube between probe and valve 

3. Probe fitting 

 

To replace the sample probe tube: 

1. Turn off the MAGPIX® and unplug the power cord. 

2. Open the side access door and locate the sample probe assembly. 

a. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to 

the right. 

3. Unscrew the sample probe fitting completely. 

4. Unscrew the ¼-28 flat-bottom fitting at the valve end of the sample probe tube. The sample probe tube is 

connected to the valve. Use pliers to disconnect the ¼-28 flat-bottom fitting if necessary. 

5. Pull the clip on the strain relief up and pull the tube down and out. 

6. Place the new tube in the strain relief by pulling up on the strain relief clip and slide the tubing up and into 

the strain relief. 

7. Screw the ¼-28 flat-bottom fitting on the end of the new sample probe tube assembly into the valve where 

you removed the fitting during the step above. 

8. Screw the probe fitting on the end of the new sample probe tube assembly into the top of the sample 

probe assembly where you removed the probe fitting in the step above. Tighten the fitting until the fitting 

clicks. 

As Needed Maintenance 

Replace the Fuses 

Periodically, you may need to replace a fuse on the MAGPIX®. Use fuses with the following specifications: F2A, 

250 V 

The fuse cartridge will accept either 5 mm x 20 mm or 0.25 inch x 1.25 inch fuses. Fuses are available from 

Luminex Corporation. Replacing a fuse requires access to the back of the MAGPIX. 

 

To avoid serious injury or death by electric shock, turn off the system and unplug the power 

cord from the wall before replacing a fuse. 
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To replace a fuse: 

1. Turn off the MAGPIX and unplug the power cord. 

2. Use a small, flat blade screwdriver to open the power module door on the lower right corner of the back of 

the system. The door opens downward, inside is a red cartridge. 

3. Use the screwdriver to remove the red cartridge. 

 

4. Check both of the fuses in the cartridge for damage. A fuse can display physical evidence of damage, for 

example, broken wire or blackened glass; if the fuse displays no physical evidence, test the fuse for 

continuity with a volt- meter. 

5. Replace any damaged fuse with the correct type of fuse . 

6. Replace the red cartridge. 

7. Shut the module door. 

8. Plug in the power cord and turn on the MAGPIX. 

 

 

Back up the System 

 

If you need to uninstall, reinstall, or install additional instances of xPONENT®, please contact 

Luminex Technical Support. Versions of xPONENT are only compatible with specific xMAP® 

instruments. Use of an incompatible version of xPONENT may lead to calibration or 

performance verification failure and is not a supported configuration. Before performing any 

software uninstall or installation steps, contact Luminex Technical Support to ensure that 

hardware and software versions are fully compatible and supported. 

Before uninstalling xPONENT® software, perform a back up of the system. You can also schedule regular 

backups of the data. 

1. Log off and exit out of xPONENT before performing a backup of the system. 

2. Navigate to the Windows logo > Luminex folder > xPONENT Archive. The Archive Utility dialog box 

displays. 

3. Click System Backup. 

a. In the Login dialog box, enter the admin User name and Password if you have the secure version 

of the soft- ware. Click OK. 

b. In the Browse For Folder dialog box, navigate to the Backup folder - which should automatically 

be chosen. Click OK. 

NOTE: The System Backup Started dialog box displays at the bottom right of the screen. 

4. Click Close in the Archive Utility dialog box. 

5. When the backup is complete, navigate to the desktop and double-click the Backup shortcut folder. You 
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will see the backup zip file and the name includes the date and time. 

 

 

Archive Data 

Set Up Automatic Archiving 

1. Navigate to the Admin page > Archive tab. 

2. Click Launch Archive Utility. The Archive Utility dialog box displays. 

3. Click Edit under Schedule Overview. The Login dialog box displays. 

a. Enter your User name and Password, if you have the secure version of the software. 

b. Click OK. 

4. Specify when you want your archives to begin, using the calendar. 

5. Using the drop-down menu, choose the frequency of how often you want to perform archives.  

NOTE: The default frequency to archive is daily. 

6. Select Reminder Only to be reminded of the need to archive, after which you must archive manually. 

Clear this check box to enable automatic archives. 

7. In To Be Archived, choose the date and batch parameters for the files you want to archive: 

• Only archive batches older than: [x] Days 

• Always keep the last: [x] Batches 

• Archive all system logs older than: [x] Days 

8. In the Archive Folder section, verify the location to which you want to archive the file(s). To change the 

location, click Browse, then navigate to the new location and click OK. 

NOTE: If you change the default archive location, ensure that the Archive Folder section reflects that 

same location when you import those archived files. 

9. Click Save to save your settings. 

Perform a Manual Archive 

Use Manual Archive only when you need to archive specific individual files. 

1. Navigate to the Admin page > Archive tab > click Launch Archive Utility. The Archive Utility dialog box 

displays. 

2. In the Archive Utility dialog box, click Manual Archive. 

3. In the Login dialog box, enter the username and password, and click OK. 

4. Use the tabs on the left side of the window to choose the type of files you want to archive. 

NOTE: Each tab opens a list of files available for archiving, except Logs, which requires only a choice of 

how old, in days, a file has to be archived. 

5. Choose the files you want to archive from the list on the left and use the arrow keys to move those files to 

the To Be Archived box on the right. For log files, select the age of the files, in days. 

6. Click Archive to move the selected files to the archive. 
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NOTE: You must archive each group of files separately. If you select a different tab without archiving first, 

xPONENT® warns you that you will lose the information in the To Be Archived box. 

7. Click Close. 

 

 

Maintenance Log 

Reproduce the following form as necessary and use them to record maintenance information. 
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Chapter 10: Storing the System 

Store the System 

To prepare the MAGPIX® for long-term storage: 

1. Navigate to the Maintenance page > Cmds & Routines tab. 

2. From the Routine name drop-down menu, choose the Prepare for Storage routine. 

3. Click Run. 

4. Remove the sample probe from the instrument and flush the sample probe with distilled water from the 

narrow end out through the larger end. 

5. Replace the sample probe in the probe holder and wrap the end of the probe with PARAFILM®. 

6. Remove the drive fluid bottle and empty the waste fluid bottle. 

7. Eject the plate carrier and remove the plate and the off-plate reagent block from the plate carrier. 

 

 

Prepare the System for Use After Storage 

To prepare the system for use after long-term storage: 

1. Make sure that the drive fluid bottle has enough drive fluid that the system is not giving you an error, and 

that the waste fluid bottle is empty. 

2. Remove the PARAFILM® from the end of the sample probe. 

3. Turn on the MAGPIX® and watch for the following indications of correct response: 

• Air blows out of the fans. 

• The syringe inside the side access door of the MAGPIX initializes. 

4. Turn on the PC and start xPONENT®. 

5. Navigate to the Maintenance page > Cmds & Routines tab. 

6. From the Routine name drop-down menu, choose Revive After Storage routine. 

7. Click Eject. 

8. Add the appropriate reagents to the reservoirs. 

9. Click Retract. 

10. Click Run. 
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Chapter 11: Shipping and 
Decontaminating the System 

If a serious problem arises with the MAGPIX®, you may need to return the system to Luminex Corporation for 

repairs. If Luminex Technical Support directs you to return the system, the Technical Support representative will 

provide you with all the necessary information as well as a Return Material Authorization (RMA) number. 

 

Before the instrument is returned, perform two procedures: Decontaminate the instrument and 

prepare the instrument for shipping. 

 

 

Decontaminate the System 

Occasions may arise when it becomes necessary to decontaminate the entire MAGPIX® system. If you must 

decontaminate the system, sanitize the accessible surfaces and the internal fluidics system. This is particularly 

important when biohazardous samples have been run. 

NOTE: Sodium hypochlorite solutions containing small amounts of sodium chloride (NaCl), sodium carbonate 

(Na2CO3), sodium hydroxide (NaOH), and other pH buffers may be used. Do not use sodium hypochlorite 

solutions containing film-forming agents, such as Diallyldimethylammonium Chloride (DADMAC), or other 

additives.   

NOTE: The xPONENT® for MAGPIX® software may refer to a 0.6% sodium hypochlorite solution with no additives 

as ‘10% to 20% household bleach’. 

 

Wear appropriate personal protective equipment (PPE) when handling parts that come into 

contact with potentially biohazardous samples. 

To decontaminate the MAGPIX system: 

1. Remove all specimens and reagents from the system. 

2. Leave distilled water and the 0.6% sodium hypochlorite solution with no additives in the off-plate reagent 

block of the system. 

3. Run a Sanitize command with a 0.6% sodium hypochlorite solution with no additives followed by two 

Wash commands with distilled water. 

4. Empty the off-plate reagent block and the waste fluid container and clean each with a 0.6% sodium 

hypochlorite solution with no additives followed by a distilled water rinse. 

5. Turn off the MAGPIX and unplug the power cord. 

6. Clean all exterior surfaces with mild detergent followed by a 0.6% sodium hypochlorite solution with no 
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additives. 

7. Open the side access door of the instrument. 

a. Insert the tool in the side access door latch and turn it one quarter turn clockwise. Slide the door to 

the right. 

8. Clean all accessible surfaces with mild detergent, followed by a 0.6% sodium hypochlorite solution with no 

additives. 

 
 

Prepare the System for Shipping 

1. Disconnect and remove the drive fluid bottle. 

2. Remove the off-plate reagent block and any plates. 

3. In xPONENT®, perform two Prime commands. This should remove fluid from the lines. 

4. Empty the waste bottle. 

5. Remove the sample probe. 

6. Re-insert the red shipping plug, included with the shipping materials provided by Luminex. 

 

 

Shipment Checklist 

Complete the following checklist, sign and date it, and return it with the MAGPIX®. 

1. Remove all specimens from the instrument. 

2. Decontaminate the instrument. 

NOTE: It is the user’s responsibility to decontaminate the instrument before shipment. 

3. Prepare the instrument for shipping. 

4. Was there an internal leak in the system? YES NO 

 

Printed Name:   

Signature:   

Company/Institution:   

Date:   

Instrument Serial Number:   
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Dispose of the System 

 

Within the European Union, the Waste Electrical and Electronic Equipment Directive requires 

that you properly dispose of electrical and electronic equipment when it reaches its end of life. 

If you are disposing of a MAGPIX® instrument, decontaminate the system. Next, contact Luminex Technical 

Support for a Return Material Authorization (RMA) number at +1-512-381-4397 (outside of the U.S.). Return the 

equipment to the following Luminex location: 

Luminex Corporation 

12201 Technology Blvd., Suite 130  

Austin, Texas 78727, USA 

For information about disposal of the system outside of the European Union, contact Luminex Technical Support. 

For information about disposal of the barcode scanner, PC, or monitor, refer to the manufacturer documentation. 



 

93 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Appendix A: Software Functionality 

Software Packages 

Multiple levels of user access can be licensed for xPONENT®. The Basic license key includes: 

• Basic Software - Allows the end user to perform analysis from protocols and batches, review and print 

reports, and perform Luminex system maintenance. 

• Instrument Control - Allows the application to connect to and communicate with an instrument identified 

by a specific serial number. 

• Remote Web Monitoring - Allows the end user to view alerts and system status from a different computer 

using a webpage. 

Additional features for which you can obtain a license: 

• Secure - Includes all of the Basic functions as well as administrator-controlled user permission levels. 

• 21 CFR Part 11 - Includes all of the Secure package features as well as the option to require electronic 

sig- natures to perform certain tasks. (Electronic signatures are listed in the system log.) 

• Automation - Includes the ability to communicate with external hardware. 

• LIS - Enables the system to communicate with an external Laboratory Information System (LIS) database. 

The LIS package enables you to export and import sample result data in ASTM file format. 

For more information about purchasing additional features, or to obtain specific package documentation, contact 

your vendor. 
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Home Page 

Figure 17: Home Page 

 

The Home page displays a welcome message, batch creation buttons, Daily Activities shortcuts, and the 

Installed Protocols list. Return to the Home page at any time by clicking Home in the navigation toolbar. 

Table 11. Home Page Screen Elements 

Click to Create a new Batch using the 

highlighted Protocol below 

Creates a new batch using a selected protocol from the 

Installed Protocols list. 

Installed Protocols Displays a list of protocols. 

Scroll Scrolls through the list of protocols. 

View 
Opens Protocols tab > Settings subtab to view the 

chosen protocol. 

Sys Info Opens Maintenance page > System Info tab. 

Reports Opens Results page > Reports tab. 

System Initialization Opens Maintenance page > Auto Maint tab. 

Certain sections of the software such as tables, lists, and text boxes have right-click option menus. Menus are 

different depending upon the item you right-clicked. 
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Table 12. Right-Click Menu Screen Elements 

Print All Prints all sections or cells of the item. 

Print Selection Prints only the selected section or cell. 

Import Imports a file. 

Export/Export Grid Contents Exports all data from the right-clicked item. 

Cut Cuts the selected data. 

Copy All Copies all data. 

Copy Copies only the selected data. 

Paste Pastes previously copied text or data into the field. 

Delete Erases text or data from the selection. 

Online Help 

English-language help is available at all times while you are using xPONENT®. 

To display online help for the page or tab you are currently working in, click the “i” icon, in the upper-right corner 

of the xPONENT window. A help window displays information specific to that page or tab. 

To display system-level help, click the "?" at the top of the xPONENT window, then click Contents and Index. A 

help window displays so you can navigate to any available topic. 

To display quick start information, click the "?" at the top of the xPONENT window, then click Quick Start. A help 

window displays information about the basic steps to start the system. 

To display software information, click the "?" at the top of the xPONENT window, then click About Luminex® 

xPONENT. The xPONENT information dialog box displays the software version information. 

System Monitor Overview 

The System Monitor is located at the bottom of all xPONENT® windows. The System Monitor displays the 

physical state of the Luminex® system. Values are reported directly from the Luminex system. 

System Status 

button 

When clicked, the System Log displays. It also displays the current status of the 

system. If there are no warnings or errors, the System Status button is green with a 

check mark. If there is a warning, out of calibration condition, or other important user 

notification, the button is yellow with an exclamation point. 
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Connected 

Status 

Displays the status of the instrument’s connection to the PC (Connected or 

Disconnected). 

Check Cal/Ver 

Status 
Displays a white X if there is a failed calibration or verification. 

Command 

display 

Displays the command currently running, the system state (i.e., running, idle, etc.), and 

date and time. 

Progress bar 

Displays a bar graph showing the progress of the current command or routine; if the 

command or routine is finished, it displays a full progress bar and the command status 

as Complete. 

Stop button 
Stops the system, regardless of command status. Use this only if it does not matter 

whether the data from the current well is lost. 

Pause button 

Pauses the system after the current command completes. Pause does not stop the 

system in the middle of running a command. You cannot run another command while 

the system is paused. Pause the system before stopping it so that it will finish the 

current command and store the pending batch and then resume exactly where it left off. 

Eject button 
Ejects the plate. Once the plate is ejected, the Eject button changes to Retract. 

Retract retracts the plate, and the Retract button changes back to Eject. 

Drive Fluid 

Level 

The drive fluid liquid level sensor warns you when the drive fluid is low. There can be 

enough drive fluid left in the bottle to finish a plate. The system does NOT stop until an 

air bubble is detected in the line coming from the drive fluid bottle. 

Waste Fluid 

Level 
The waste fluid bottle liquid level sensor stops the current plate if the waste bottle is full. 

Delta Cal Temp 
Displays the difference in temperature between the current reading and the reading 

when the system was calibrated, in degrees Celsius. 

XY Status 
Displays the current location of the command, and the temperature of the plate heating 

block in degrees Celsius. 

Power Off button Powers off the instrument. 

Arrange Main Navigation Pages 

NOTE: The Home page cannot be moved. The Admin page cannot be removed if a security license is not being 

used, or if the user currently logged in is set up as a member of the Administrator group profile. 

To arrange the main navigation buttons: 

1. Navigate to the Admin page > System Setup tab. 
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2. In the Arrange Main Navigation Button section, select or clear the check boxes by each page name to 

hide or display the page. 

3. Click a main page header and then click the up and down arrows to change the order in which the pages 

display, from left to right. 

4. Click Save. 

5. Click Default if you want to restore the main navigation. 

6. In the Settings Saved dialog box, click OK. 

 

 

Samples Page 

Samples Tab 

Use the Samples tab to create new samples, view the sample list, create a batch, and to view and edit samples 

for protocols. The Samples tab is intended to be used with an LIS. If you want to import a sample list, use the 

Import List function when creating the batch or editing the protocol. 

Figure 18: Samples Tab 

 

Table 13. Samples Tab Screen Elements 

Create New Samples Creates a new sample. 

Details View and edit sample details for the chosen protocol. 
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Create Batch Creates a LIS batch for the protocol. 

Create Sample Subtab 

Use the Create Sample subtab to enter and view sample information. 

Click Create New Samples from the Samples tab to display the Create Sample subtab. In the Sample section, if 

you have the Laboratory Information System LIS-enabled version of the software and are currently connected to 

the LIS, the sample list auto-populates when the LIS provides sample orders. You can only view or run a sample 

list created in the LIS; you cannot edit it. 

Edit Samples Subtab 

Use the Edit Samples subtab to edit a sample for the chosen protocol. 

 

 

Batches Page 

Batches Tab 

Use the Batches tab to create a new batch from an existing protocol, and create a new multi-batch. 

Figure 19: Batches Tab 
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Table 14. Batches Tab Screen Elements 

Create a New 

Batch from an 

existing Protocol 

Creates a new batch from an existing protocol. 

Create a New 

Multi-Batch 
Creates a new multi-batch. 

Pending Batches 
Displays the name of the protocol used with the batch, the protocol version, date, and 

status for each pending batch. 

Single Step 

Instructs the system to acquire one well and then pause. If Single Step is activated 

during a batch, the batch pauses at the end of the current well. This ensures that the 

system is working currently before you run an entire batch. 

Save Prtcl Saves protocol and/or assay information for a standard/control 

Plate Layout 
Opens the Report dialog box, which includes the Batch Plate Layout Report. Confirm 

that the plate layout conforms to your specific assay instructions. 

Import Imports a batch, not previously run in xPONENT®, from a folder on the PC. 

Export 
Exports the batch information in order to move it to another computer, make a copy of 

the data, and then import it into xPONENT on another computer. 
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Batches Tab > Protocol Subtab 

Use the Protocol subtab to name a batch, enter a batch description, choose the protocol needed for running the 

batch, and view active reagents. 

Figure 20: Protocol Subtab 

 

Table 15. Protocol Subtab Screen Elements 

Batch Name/Description Batch name and batch description. 

Select a Protocol 
Contains the protocol name, version, manufacturer, and creation date for each 

protocol. 

Active Reagents 

Displays assay and control lots/kits associated with the selected protocol. The 

Stds/Ctrls Kit Name - Lot# field displays the assay standard/control kit/ lot name 

and lot number currently associated with the selected protocol. 

 

  



 

101 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Batches Tab > Stds & Ctrls (Standards and Controls) Subtab 

Use the Stds & Ctrls subtab to apply a kit or lot. 

Figure 21: Stds & Ctrls Subtab 

 

Table 16. Stds & Ctrls Subtab Screen Elements 

Apply Std/Ctrl 

Kit 
Applies a Std/Ctrl Kit. The chosen kit must be associated with the same analyte names. 

Assay 

Standard 

Information 

Displays the chosen standard reagents in a list. 

Click the Reagent column header to re-sort the order from the highest number standard to 

standard number one. This is useful for applying dilutions in which the last standard is the 

highest standard. 

Apply Std Lot - Applies a standard lot. 

Apply Values arrow buttons - Applies a value down or across the list of analytes. 

Assay Control 

Information 

Lists the selected control reagents. Existing control lot information can be applied or new 

information can be entered manually. 

Apply Ctrl Lot - Applies a control lot. 

Show Value - Expected, Low, and High set the expected, lowest, or highest acceptable 

con- centration of the analyte in the sample. 



 

102 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Apply Values arrow buttons - Applies a value down or across the list of analytes. 

Dilution 

• 1:2 - Halves the standard from each previous iteration. 

• 1:10 (Log) - Computes a value of one-tenth of the standard from each previous 

iteration. 

• 1/2 Log - Creates a 1:3.16 dilution, or half of each 1:10 (Log) from each previous 

iteration. 

Apply Dilution 

Applies the dilution selected in the Dilution list. 

NOTE: The Dilution list and Apply Dilution button are displayed only if a quantitative 

analysis has been selected. 

NOTE: You can also manually type a number to set your own dilution factor. It must be a 

whole number. 
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Batches Tab > Plate Layout Subtab 

Use the Plate Layout subtab to define commands that apply to one or more wells, define off-plate and 

maintenance commands, and define well locations for samples, standards, controls, and background. 

Figure 22: Plate Layout Subtab 

 

Table 17. Plate Layout Subtab Screen Elements 

Plate Image 
Represents the plate. Each well appears as a circle on the grid. Well commands appear 

in the appropriate circles as you assign them to wells on the plate. 

Command 

Sequence 

Contains the command sequence for the active plate. A command's ID and Dilution 

fields have a blue border around them if they can be double-clicked to enter 

information. 

Move Command Changes the acquisition order of a command. 

Replicate Count 
Defines a quantity of replicate sets from one to nine. Replicate count selection must be 

made before adding a well command 
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Grouping 

Selects the sequence in which the replicates are laid out in plate wells. Options for 

Grouping are: 

• 123123123. . . Lays out one of each replicate set at a time in numerical order. 

• 111222333. . . Lays out all the replicates in a set before moving on to the next set 

in numerical order. 

Each command is associated with a color. Click and drag to highlight a series of wells; 

click a column or row header to highlight the entire column or row, or click and highlight 

different wells and then click a command below to assign that command to all the 

highlighted wells. 

• Unknown (U): Yellow 

• Background (B): Purple 

• Control (C): Red 

• Standard (S): Green 

Delete - Removes the well command from the selected well. 

Start at Well - Enables you to begin acquisition at a well other than A1. 

Commands and 

Routines 

Allows you to add and delete commands and routines, and to create pre and post batch 

routines. If you select a routine you created, that routine must also exist on any system 

to which you import this protocol. The system displays an error when attempting to run 

a batch on a system where the routine does not exist. 

Wells and commands you assign to the protocol plate layout are saved into the protocol 

set- tings and execute each time you use the protocol to run a batch. Standards and 

controls associated with a given protocol typically remain constant, while the number of 

unknown wells often varies. You can assign a specific number of unknown wells to the 

plate when setting up a batch. 

Before adding well commands, delete all standards from the plate layout if any of the 

standards need to be rearranged. Delete all controls from the plate layout if any of the 

controls need to be rearranged. 

Add - Adds a command or routine to the selected well. 

Delete - Deletes any command or routine associated with the selected well. 

Pre-Batch Routine - Adds the command or routine before running the batch. 

Post-Batch Routine - Adds the command or routine for running the batch. 

Plate 

Specifies the plate to display in the plate image in the list. 

Add Plate - Adds a new plate to the batch. 
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Delete Plate - Deletes the plate highlighted in the list. 

Direction 

Specifies the direction to run the plate commands. The selected direction also dictates 

how wells are added to the plate when assigning multiple unknowns, standards, and 

controls at one time. 

Plate Navigation Displays a smaller plate image for the current batch. 

Single Step 

Instructs the system to acquire one well and then pause. If Single Step is activated 

during a batch, the batch pauses at the end of the current well. This ensures that the 

system is working currently before you run an entire batch. 

Off Plate Area Displays the location for maintenance commands in the Command Sequence list. 

Save Prtcl (When 

creating a batch) 
Opens the Save Protocol dialog box to save the protocol and/or kit. 

Run Batch 
Runs the batch and opens the Current Batch tab, where you can monitor the batch as 

it runs. 

Import List Imports a sample list into the Command Sequence section. 

Batches Tab > Settings Subtab 

Use the Settings subtab to name your new batch and configure acquisition settings, view the acquisition 

parameters of the selected saved batch (for existing batches), and print the batch settings report. 

NOTE: When running a kit with a provided protocol, the protocol for the assay must be run as instructed in the 

assay's package insert. 

Table 18. Settings Subtab Screen Elements 

Volume 

The instrument acquires from the sample well the desired sample volume (µL). Use 

values ranging from 20 µL to 200 µL. To avoid air intake, add an additional 25 μL to 

the sample volume in each well. The default value is 50 μL. 

XY heater 
Select Enabled to enable the XY heater. In the field, type the desired value in 

degrees C. The temperature range is 35°C to 60°C in 0.5 increments. 

 

Acquiring data before the heater has reached the proper temperature can 

compromise test results. 
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Analysis Type 

Use this list to choose from the following analysis types: 

None - No analysis. Choose if you have your own data post-processing program 

and want to obtain only fluorescent intensity results. You cannot apply standards or 

controls when you select None. You cannot analyze acquisitions with this setting. 

Qualitative - Qualitative analysis determines results as either positive or negative, 

reactive or non-reactive. The software is flexible in defining custom result ranges, 

such as negative, low positive, or high positive. Determinations are based on a 

single standard. For qualitative analysis the Luminex software uses a specific 

algorithm, shown below. 

(FIsample)/(FIstandard) = Ki 

Where FI = Fluorescent Intensity and Ki = a “Quali” value entered in lot information 

to determine the value or the qualitative assay standard. 

The “Quali” value determines a cutoff or threshold. This, in conjunction with ranges 

using the Lum Qual formula or an edited range specific for your assay, helps to 

determine qualitative results for unknown samples. 

Two predefined formulas using the algorithm are included in the system. You can 

use them as is or edit their range values to meet your requirements 

Quantitative - Determines the sample concentrations from standard curves using 

regression methods. Cubic Spline, Linear, Logistic 4P, and Logistic 5P. Enter the 

desired values for standards and controls in the Number of Standards and 

Number of Controls fields. Select either Fit of All Standards or Mean of 

Replicates for the calculation of the curve fit. 

Luminex recommends Fit of All Standards as the most accurate calculation of the 

curve fit. 

Based on a range of quantitative, numerical results, a threshold range can be 

applied to a quantitative analysis, for example, high, low, saturated, and expected. 

Number of 

Standards 

The number of standards for the protocol. Applies only to qualitative and quantitative 

analysis. 

Number of Controls 
The number of controls for the protocol. Applies only to qualitative and quantitative 

analysis. 

Fit of all Standards 

Determines the standard curve by using each individual standard replicate when 

calculating the standard curve. For example, if you run duplicates of a 7-point 

standard curve, the software will calculate the standard curve by using 14 points. 

Applies only to quantitative analysis. 
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Mean of Replicates 

Averages the individual standard replicates when calculating the standard curve. 

Applies only to quantitative analysis. For example, if you run duplicates of a 7-point 

standard curve, the software will calculate the standard curve by using 7-averaged 

points. 

Analyze results 

while acquiring 

samples 

The software allows real-time viewing of the results as the instrument analyzes 

samples. This feature is not available if you chose None as your analysis type. 

Use External 

Analysis Program 

Use a third-party program to analyze the data. The Analysis Program list becomes 

active. Applies only to qualitative and quantitative analysis. 

Batches Tab > Analytes Subtab 

Use the Analytes subtab to select or edit analytes used in the batch or protocol. 

Figure 23: Analytes Subtab 

Table 19. Analytes Subtab Screen Elements 

Analytes grid 

A grid representing each analyte from 12 to 78. 

Select All - Selects all analytes. 

Deselect All - Deselects all analytes. 
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Count 

The desired bead count for the analytes. The instrument will analyze the sample until it has 

analyzed the count chosen for each bead region or until the timeout is reached if that 

feature was enabled. 

Units Enter the desired units for the analytes in this field. 

Apply All Applies the information in the Units and Counts fields to all analytes. 

Setting Up Batches 

Batches consist of protocols and samples for acquisition and can span more than one plate. Protocols contain 

predefined commands that must be included in every batch acquisition. You can group batches together as a 

multi-batch. Multi- batches can consist of any number of batches that have been set up from different protocols 

and are processed consecutively. Multi-batches cannot be run on multiple plates. 

When setting up a batch, if the number of samples exceeds the number of wells in one plate, you can add 

additional plates in the Add and Change Plate section. Additional plates are identified on the bottom of the plate 

image as Plate a of b, where a is the plate number and b is the total number of plates. 

NOTE: Luminex recommends that the manufacturer assay kit controls are analyzed with each plate. 

Assay kit manufacturers may provide protocols in their kits which are distributed on media. Protocols typically 

include assay values for standards and controls, and maintenance commands (such as washes or primes to 

acquire along with samples). Assay reagents are included in assay kits. You must provide information about these 

reagents, such as lot numbers and concentration values for the standards and assay controls. 

New Multi-Batch Subtab 

Use the Create New Multi-Batch button to add or remove batches to the multi-batch set up and to run a multi-

batch. 

A multi-batch is a set of batches that you want to process consecutively. Add batches to the multi-batch from 

pending batches in your database. You can also create a new batch to add to the database for the multi-batch. 

Include as many batches as you need, up to 96 batches. This feature enables you to conserve plates. 

Ensure that batches fit on one plate. If space limitations create an overlap, an error message displays. Results for 

each batch are saved as individual batch files. 

Table 20. New Multi-Batch Subtab Screen Elements 

Select Pending 

Batch 
Contains a list of all pending batches. Select the batch you want to add to the plate. 

Multi-Batch 
Lists pending batches selected for the multi-batch. The list includes name and “Start at” 

well. 

Plate Layout Opens the Multi-batch Report dialog box 
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Multi-batch 

Plate Layout 

Report 

Includes the multi-batch plate layout, command number, plate location, command type, 

sample ID and dilution. The report is date and time stamped. 

New Batch Creates your new batch. 

Add 

Adds a batch from available options. The selected batch then appears on the plate 

layout. After you add each batch, the software automatically adds the next batch to the 

first well of the next column or row (depending on the plate direction). You can also select 

a well first, which places the next batch in your chosen location. 

Remove 

Removes a selected batch in the Multi-Batch list. The batch still remains in the Pending 

Batches section This button is displayed only if you have added a batch to the Multi-

Batch list and selected the batch from the list. 

 

 

Results Page 

Once a batch has begun running, observation and analysis take place in the Results page. This page contains the 

following tabs and subtabs: 

• Current Batch tab - View statistics for the current run and analyte progress per well. 

• Saved Batches tab - View information about already processed batches and, if necessary, replay them or 

recalculate their data. 

• Click Replay > Recalculate Data from the Saved Batches tab. 

• Click Replay > Replay Batch from the Saved Batches tab. 

• LIS Results tab - View a batch or transmit a batch that contains Laboratory Information System (LIS) 

results. 

• Reports tab - This tab enables you to select a report to view. 

Performing Analysis 

If you are using a third-party software to perform analysis, see the user manual provided with that software. 

Follow the assay's package insert when running a kit with data analysis instructions. 

NOTE: Luminex recommends using median statistics for data analysis. 

You can direct the system to acquire samples in replicate regardless of batch type. For qualitative batches, 

qualitative results for replicates are averaged, and the reported interpretation is determined from this replicate 

average. 

Replicates in quantitative batches are based on a standard curve that is generated by either the “Fit of all 

standards” or “Mean of replicates.” The default is “Fit of all standards.” Unknown samples are calculated from the 

standard curve. Test results for replicate samples are averaged to determine the reported quantitative result 

denoted as “AVG.” 

You can analyze a batch using the analysis features of Qualitative and Quantitative or None. 
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Current Batch Tab 

Use the Current Batch tab to view results, statistics, and log information related to the current batch, and to 

perform statistical analysis on batch results. This tab offers real-time monitoring of batch sampling during 

acquisition through a dis- play of sample bead statistics and analytes, and dot plot data. The statistics available 

on this tab are individual well bead statistics. They do not describe replicate well assay results. 

There are four maximize buttons in this window, one for each major pane. Click the appropriate button to 

maximize the pane. Click the minimize button at the top right of the pane to return to its standard size. 

Figure 24: Current Batch Tab 

 

Table 21. Current Batch Tab Screen Elements 

Statistic 

To view a particular statistic for analytes in a batch, choose one of the options on the drop-

down menu. The statistical options displayed change according to the type of analysis. 

NOTE: Trimmed statistics remove the lower and upper 5% of the extreme statistic values, 

then use the remaining values for the Mean, Standard Deviation, or %CV calculations. 

Trimmed statistics remove outliers, ensuring that the data is more representative of the 

population. 

Median Fluorescence Intensity (MFI) - The value (detected signal) that is in the middle of 

the micro- sphere population when sorted by reporter value, lowest to highest. The median 

value is much less sensitive than the mean value, due to outliers and carryover. 
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Test Result - The calculated analysis value for quantitative or qualitative assays derived 

from standards with known values. 

Range - A semi-quantitative result for a particular numerical result falling between a 

predefined set of values such as Normal or Negative. 

Net MFI (Sample Well MFI - Background Well MFI) - The Net MFI can be used to eliminate 

the effect of background signal in an assay. 

Count - The number of microspheres detected within the specified microsphere region. 

Micro- spheres that are not inside the region on the dot plot are not included. 

Mean - Average of all values for the microspheres detected in a region. 

Trimmed Mean - (Optional) The sum of the data points in the trimmed distribution divided by 

the number of data points. 

Trimmed Mean = Σxi / Nt 

% CV of microspheres - The measure of relative dispersion within the distribution. 

% CV = 100 x Std Dev / Mean 

Standard Deviation - For calculating sample variability or dispersion, Luminex uses the 

standard deviation formula. 

Peak - The value that is equal to the largest number of data points within the distribution. For 

example, in data set {1,2,2,3,3,3,4,5}, 3 is the peak because it occurs the most frequently in 

the distribution list. 

% CV of Replicates - The measure of relative dispersion within the distribution of results for 

replicate samples. 

% CV = 100 X Std Dev / Mean 

% Recovery - A measure of how accurately your observed results match your expected 

results following regression analysis. 

(Observed concentration) / (Expected concentration) x 100% 

Expected Result - The known or expected test result value for a standard or control. 

Control Range - Low - The lowest value for an assay control used to determine pass/fail 

criteria for an assay. 
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Control Range - High - The highest value for an assay control used to determine pass/fail 

criteria for an assay. 

Normalized Net - Median - For each analyte in a well, the Normalized Net Median (NNM) = 

(net median of analyte) / (net median of normalization bead) 

Units - The unit of measure for an analyte, for example, pg/mL. 

Trimmed Count - (Optional) The number of data points in the trimmed distribution (Nt). 

Trimmed % CV of microspheres 

Trimmed Standard Deviation - (Optional) The measure of dispersion within the trimmed 

distribution. 

Trimmed Std Dev = ((Nt Σxi 2 - Σxi)2) / Nt (Nt -1))1/2 

Trimmed Peak - (Optional) The value that is equal to the largest number of data points 

within the trimmed distribution. 

Analyte 
Contains a list of analytes run in the batch. Select an analyte to view all statistics for that 

analyte. 

Well(s) to 

View: 

Current Well - Displays the statistics of the well currently being displayed. (This changes to 

Displayed Well if viewing a batch using the Open button of the Saved Batches tab. 

Single Step - Instructs the system to acquire one well and then pause. If Single Step is 

activated during a batch, the batch pauses at the end of the current well. This ensures that 

the system is working correctly before you run an entire batch. 

Results 

Displays statistics related to the batch. Use the up, down, left, and right arrow buttons to 

move through the table, or use the scroll bars. The Results will only display when a batch is 

actively running or when a batch is replayed and not recalculated. 

Plate Select the plate you want to view, if there is more than one plate. 

 

If using multiple plates, ensure that plates are used in the proper order. Failure to do so can 

result in inaccurate data and test results. 
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Well Report 

This pane displays a representation of the plate and the status of acquired wells on the left 

side of the page. Each well displays one of three possible states: 

• Yellow - Well acquired, but the system detects a possible problem. 

• Green - Well acquired successfully. 

• Red - Well acquisition unsuccessful; the system might have stopped, depending on the 

circumstances. 

Dot Plot 

The default location of the dot plot is the lower-right section of the Current Batch tab. The dot 

plot is a graphical display of real-time data collection. When using 1 to 50 beads, the dot plot 

default dis- play shows Classification 1 (CL1) and Classification 2 (CL2). 

Log 

This pane displays a log of system processes at the bottom of the Current Batch page. Log 

entries indicating warnings are highlighted in yellow; errors are highlighted in red. Other log 

entries are not highlighted. The log includes the following information: 

• Date 

• Message 

• Code 

Progress 

Click to display real-time progress of the well acquisition. Analyte counts are displayed in a 

dynamic bar graph as they are acquired. The scroll bar at the bottom of the Progress display 

scrolls through the analyte list. A zoom feature on the left of the display enables you to 

enlarge the image. 

Save Image Opens a Save As dialog box to save a screen capture. 

Default Appears only when the progress display is active. Click to return to the dot plot display. 
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Saved Batches Tab 

Use the Saved Batches tab to open a completed batch, view completed batch details, import, export, or approve a 

batch, and replay or reacquire a batch. 

On the Saved Batches tab click Open to display the following subtabs on the left side of the page: Results, 

Settings, Log, and Sample Details. 

Figure 25: Saved Batches Tab 

 

Table 22. Saved Batches Tab Screen Elements 

Filter Displays the saved batches you want to display in the Completed Batches list. 

Clear Turns off the filter. 

Completed 

Batches 
Displays a list of completed batches. 

Reacquire Reacquires the selected batch. 

Save Prtcl Opens the Save Protocol dialog box, displaying the kit information for the selected batch. 
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Plate Layout Displays the Batch Plate Layout Report. 

Approve Approves the batch. 

Exp Results 
Choose an export destination for the .csv file containing your results. If you plan to replay 

this batch in the future, be sure to include the raw (.lxb) files. 

Import 
Imports a batch file (.mdf). Select Include Raw Files (LXB) to include raw files in the 

import. 

Export Exports a file. Select Include Raw Files (LXB) to include raw files in the export. 

Replay 
Enables you to use the data stored in the run files from the initial acquisition to reprocess a 

batch, creating a new batch output file. 

Open Displays the saved batch results for the selected batch. 

Saved Batches Tab > Results Subtab 

Table 23. Results Subtab Screen Elements 

Statistic 

To view a particular statistic for analytes in a batch, select one of the options on the drop-

down menu. The statistical options displayed change according to the type of analysis. 

NOTE: Trimmed statistics (indicated by *) remove the lower and upper five percent of the 

extreme statistic values, then use the remaining values for the Mean, Standard Deviation, or 

%CV calculations. The point of a trimmed statistic is that it removes outliers, ensuring that 

the data is more representative of the population. 

Median Fluorescence Intensity (MFI) - The value (detected signal) that is in the middle of 

the microsphere population when sorted by reporter value, lowest to highest. The median 

value is much less sensitive than the mean value, due to outliers and carryover. 

Test Result - The calculated analysis value for quantitative or qualitative assays derived 

from standards with known values. 

Range - A semi-quantitative result for a particular numerical result falling between a 

predefined set of values such as Normal or Negative. 

Net MFI (Sample Well MFI - Background Well MFI) - The Net MFI can be used to eliminate 

the effect of background signal in an assay. 

Count - The number of microspheres detected within the specified microsphere region. 

Micro- spheres that are not inside the region on the dot plot are not included. 

Mean - Average of all values for the microspheres detected in a region. 
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Trimmed Mean - (Optional) The sum of the data points in the trimmed distribution divided by 

the number of data points. 

Trimmed Mean = Σxi / Nt 

% CV of microspheres - The measure of relative dispersion within the distribution. 

% CV = 100 x Std Dev / Mean 

Standard Deviation - For calculating sample variability or dispersion, Luminex uses the 

standard deviation formula. 

Peak - The value that is equal to the largest number of data points within the distribution. For 

example, in data set {1,2,2,3,3,3,4,5}, 3 is the peak because it occurs the most frequently in 

the distribution list. 

% CV of Replicates - The measure of relative dispersion within the distribution of results for 

replicate samples. 

% CV = 100 X Std Dev / Mean 

% Recovery - A measure of how accurately your observed results match your expected 

results following regression analysis. 

(Observed concentration) / (Expected concentration) x 100% 

Expected Result - The known or expected test result value for a standard or control. 

Control Range - Low - The lowest value for an assay control used to determine pass/fail 

criteria for an assay. 

Control Range - High - The highest value for an assay control used to determine pass/fail 

criteria for an assay. 

Normalized Net - Median - For each analyte in a well, the Normalized Net Median (NNM) = 

(net median of analyte) / (net median of normalization bead) 

Units - The unit of measure for an analyte, for example, pg/mL. 

Trimmed Count - (Optional) The number of data points in the trimmed distribution (Nt). 

Trimmed%CV of microspheres 

Trimmed Standard Deviation - (Optional) The measure of dispersion within the trimmed 

distribution. 

Trimmed Std Dev = ((Nt Σxi 2 - Σxi)2) / Nt (Nt -1))1/2 
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Trimmed Peak - (Optional) The value that is equal to the largest number of data points 

within the trimmed distribution. 

Analyte 
Contains a list of analytes run in the batch. Select an analyte to view all statistics for that 

analyte. 

Displayed 

Well 
Displays the number of the well whose contents currently appear in the table. 

Results 

pane 
Displays statistics related to the batch. 

Save Image Saves a screen capture. 

Plate 

Select the plate you want to view, if there is more than one plate. 

 If using multiple plates, ensure that plates are used in the proper order. Failure to 

do so can result in inaccurate data and test results. 

Well Report 

This pane displays a representation of the plate and the status of acquired wells on the left 

side of the page. Each well displays one of three possible states: 

• Yellow - Well acquired, but the system detects a possible problem 

• Green - Well acquired successfully 

• Red - Well acquisition unsuccessful; the system might have stopped, depending on the 

circumstances 

Dot Plot 

The default location of the dot plot is the lower-right section of the Current Batch tab. The dot 

plot is a graphical display of real-time data collection. When using 1 to 50 beads, the dot plot 

default display shows Classification 1 (CL1) and Classification 2 (CL2). 

Log 

This pane displays a log of system processes at the bottom of the Current Batch page. Log 

entries indicating warnings are highlighted in yellow; errors are highlighted in red. Other log 

entries are not highlighted. The log includes the following information: 

• Date 

• Message 

• Code 

Progress 

Click to display real-time progress of the well acquisition. Analyte counts are displayed in a 

dynamic bar graph as they are acquired. The scroll bar at the bottom of the Progress display 

scrolls through the analyte list. A zoom feature on the left of the display enables you to 

enlarge the image. 



 

118 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Formula 

Opens the Change Analysis dialog box with a list of analytes used in the batch. Click an 

analyte to open the Analysis Settings dialog box from which you can select a new analysis 

setting for the analyte. 

Default Returns view to Results page. 

Approve Opens the Batch Approval Confirmation dialog box to approve the batch. 

Validate Validates an entire selected row or cell in the Results table. 

Invalidate Invalidates an entire selected row or cell in the Results table. 

Saved Batches Tab > Settings Subtab 

When you click the Settings subtab, a report generates displaying the following: 

• A date and time stamp at the top of the report 

• Left and right Page arrow buttons so that you can view pages in the report 

• Calibration State 

• Machine Information 

• Assay Lots Used 

• Tests 

• Protocol Settings 

Saved Batches Tab > Log Subtab 

The Log subtab displays a log of the activity which occurred during the acquisition of the selected batch. The 

following information is displayed about each activity: 

• Date - date and time well was acquired 

• Message - log message about the well 

• Code - command and error codes 

Log entries display yellow if a well was acquired but there was a possible problem, and red if acquisition failed. 

• Print - Prints the log 

• Export - Opens the Save As dialog box to save the batch log file. Select a location and click Save 

• Close - Reopens the Saved Batches tab 
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Saved Batches Tab > Sample Details Subtab 

Table 24. Sample Details Subtab Screen Elements 

< and > Arrows Scroll left to right through the sample details. 

^ and v Arrows Scroll up and down through the sample details. 

Transmit Sends the results. 

Reports Tab 

Use the Reports tab to generate, view, and print reports. 

Table 25. Reports Tab Screen Elements 

Report and 

Type list 

Report lists the categories of reports. The selections in the Type list change depending on 

the selection you made from the Report list. 

Generate 

Generates the report, The Data Interpretation Report displays, with additional buttons, 

depending on the size of the report. 

Page - Use the arrows to scroll through the pages being displayed. 

Save - Saves the analyte information currently displayed. 

Print - Prints the analyte information currently being viewed. 

New Report - Returns you to the main Reports window. 
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Protocols Page 

Protocols Tab 

Use the Protocols tab to choose an existing protocol. 

Figure 26: Protocols  
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Protocols Tab > Settings Subtab 

Figure 27: Settings Subtab 

 

 

Table 26. Protocols Tab > Settings Subtab Screen Elements 

Name and Description 

fields 
The name and description of the protocol. 

Version Version number of the protocol. 

Manufacturer Manufacturer of the protocol. 

Volume 

The volume the instrument aspirates in to the system for analysis. Enter the 

desired sample volume in microliters. Use values from 20 µL to 200 µL. To avoid 

air intake, add at least 25 µL to the sample well in addition to the sample size. The 

default value is 50 µL. 

XY heater 

Select Enabled to enable the XY heater. In the field, type the desired value in 

degrees C. The temperature range is 35°C to 60°C in 0.5°C increments. 

NOTE: Acquiring data before the heater has reached the proper temperature can 

compromise test results. 

Plate Name 
The name assigned to the plate during sample probe height adjustment. Choose 

the correct plate from the list. 
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Sample Wash 

This option is for assays without a final wash step prior to reading the plate on the 

instrument. This automatically washes each sample within the instrument. Final 

washes are required for proper analysis. 

Analysis Type 

Use this list to choose from the following analysis types: 

None - No analysis. Choose if you have your own data post-processing program 

and want to obtain only median fluorescent intensity results. You cannot apply 

standards or controls when you select None. You cannot use xPONENT® to 

analyze acquisitions with this setting. 

Qualitative - Qualitative analysis determines results as either positive or 

negative, reactive or non-reactive. 

Quantitative - Quantitative analysis determines the sample concentrations from 

standard curves using regression methods: Cubic Spline, Linear, Logistic 4P, 

and Logistic 5P. 

Number of Standards 
Number of standards for the protocol. Applies only to qualitative and quantitative 

analyses. 

Number of Controls 
Number of controls for the protocol. Applies only to qualitative and quantitative 

analyses. 

Fit of all Standards 
Use each individual standard replicate when calculating the standard curve. 

Applies only to quantitative analysis. 

Mean of Replicates 
Average the individual standard replicates when calculating the standard curve. 

Applies only to quantitative analysis. 

Use External Analysis 

Program 
This option is for those using a program other than xPONENT® to analyze 

collected data. Applies only to qualitative and quantitative analysis. 

Analyze results while 

acquiring samples 

The software allows real-time viewing of the results as the instrument analyzes 

samples. This feature is not available if you select None as your analysis type. 
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Protocols Tab > Analytes Subtab 

Use the Analytes subtab to select or edit analytes used in the batch or protocol. 

Figure 28: Analytes Subtab 

 

Table 27. Analytes Subtab Screen Elements 

Analytes grid A grid representing each analyte from 12 to 78. 

Select All Selects all analytes. 

Deselect All Deselects all analytes. 

Default Analysis 

The default analysis changes based on the Analysis Type selected in the 

Settings subtab. If Qualitative or Quantitative was chosen on the Settings 

subtab, click Change to change the analysis settings for all analytes. 

Count 

The desired bead count for the analytes. The instrument will analyze the sample 

until it has analyzed the count chosen for each bead region or until the timeout 

is reached if that feature was enabled. 

Units Enter the desired units for the analytes in this field. 

Apply All Applies the information in the Units and Count fields to all analytes. 
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Selected analytes are 

displayed in a list on the 

right side of the 

Analytes grid. This list 

includes the following 

information: 

Name - The name of the analyte. Click and type to rename the analyte. 

Analysis - Click this field and choose another analysis from the list, if you want 

to change it. 

Units - The unit of measurement you specified in the Unit field. Click this field to 

enter a value for the analyte. 

Count - Enter the desired bead count for the analytes. If each selected bead set 

does not acquire this number of events, a warning is added to the log that not 

enough bead events were acquired. 

Region - Refers to the specific analyte selected. 

Protocols Tab > Plate Layout Subtab 

Figure 29: Plate Layout Subtab 
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Table 28. Plate Layout Subtab Screen Elements 

Plate Image Represents the plate. Each well appears as a circle on the grid. 

Command 

Sequence 

Contains the command sequence for the active plate. A command's ID and 

Dilution fields have a blue border around them if they can be double-clicked to 

enter information. 

Move Command 
Moves a selected well command in the plate up or down in the Command 

Sequence list, changing the acquisition order. 

Import List 

Imports an existing command sequence list. 

NOTE: The import feature allows you to import sample information into unknown 

wells or wells with specified locations. 

Replicate Count 
Defines a quantity of replicate sets from one to nine. Replicate count selection 

must be made before adding a well command. 

Grouping 

Selects the sequence in which the replicates are laid out in plate wells. Grouping 

selections must be made before adding a well command. Options for grouping 

are: 

123123123. . . Lays out one of each replicate set at a time in numerical order. 

111222333. . . Lays out all the replicates in a set before moving on to the next 

set in numerical order. 

Each command is associated with a color. Click and drag to highlight a series of 

wells, click a column or row header to highlight the entire column or row, or click 

and high- light different wells and then click a command below to assign that 

command to all of the highlighted wells. 

Delete - Removes the well command for the selected well. 

Start at Well - Enables you to begin acquisition at a well other than A1. 

Commands and 

Routines 

Assigns maintenance commands and routines to a well after you select it in the 

Command Sequence or plate image area. 

NOTE: If you select a routine you created, that routine must also exist on any 

system to which you import this protocol. The system displays an error when 

attempting to run a batch on a system where the routine does not exist. 

Add - Opens the Commands and Routines dialog box so you can choose a 

command or routine. 

Delete - Deletes the chosen command or routine. 
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Post-Batch Routine - Adds the command or routine before running the batch. 

Pre-Batch Routine - Adds the command or routine for running the batch. 

Plate 

Specifies the plate you want to display in the plate image. 

Add Plate - Adds a new plate to the batch. 

Delete Plate - Deletes the plate highlighted in the list. 

Direction 

Specifies the direction to run the plate commands. Select either horizontally or 

vertically. The selected direction also dictates how wells are added to the plate 

when assigning multiple unknowns, standards, and controls at one time. 

Plate Navigation 

Displays a smaller plate image for the current batch. Click and drag in the plate 

layout to select wells to display. The Plate Navigation section in the lower right 

part of the window can be used to display all the wells in the plate image. Click 

and drag in the Plate Navigation dialog box to display different portions of the 

plate. 

Off Plate Area 
Designates an alternate location for maintenance commands in the Command 

Sequence list. 

Save Prtcl 

(When creating a 

batch) 

Opens the Save Protocol dialog box to save the protocol and/or kit. Click Save 

Protocol and/or Save Std/Ctrl Kit to save the protocol and/or kit. 

Enter the appropriate information in the fields and click Save to save the protocol 

or kit. 

Run Batch Runs the batch. 
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Stds & Ctrls (Standards and Controls) Tab 

Use the Stds & Ctrls tab to delete, edit, export, import, and create standards and controls. 

Figure 30: Stds & Ctrls Tab 

 

Table 29. Stds & Ctrls Tab Screen Elements 

Create New Std/Ctrl 

Lots 

Opens the Select Protocol dialog box. After you choose the protocol, the 

Std/Ctrl Details subtab displays so you can create a new lot or kit. 

Installed Kits And Lots 

Displays information about the kits and lots currently installed on the system. 

Show - Click either Std/Ctrl Kits Only or All Lots to choose what to display. 

Select All Lots to display the following information about each installed lot: 

Reagent, Lot #, Expiration, Name, Manufacturer, Protocol, Versions, Std/Ctrl Kit 

#, and Std/Ctrl Kit Name. 

Select Std/Ctrl Kits Only to display the following information about the 

Installed Std/Ctrl Kits: Std/Ctrl Kit #, Std/Ctrl Kit Name, Expiration, 

Manufacturer, Created with Protocol, and Version. 

Group lots from the same Std/Ctrl Kit together - Groups lots from the same 

kit together. 
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Export Exports the selected lot. Select a location to save the lot file, and click Save. 

Import Select a Std/Ctrl Kit or lot file to import, and click Open. 

Protocols Tab > Stds/Ctrls Details (Standards and Controls) Subtab 

Use the Std/Ctrl Details subtab to create, edit, or view a kit. 

Figure 31: Stds/Ctrls Details Subtab 

 

 

Table 30. Std/Ctrl Details Subtab Screen Elements 

Apply Std/Ctrl 

Kit 
Applies a Std/Ctrl kit. 

Assay Standard 

Information 

Displays the selected standard reagents in a list. 

Apply Std Lot - Applies the standard lot. 

Apply Values - Applies a value across or down the Reagent, Name, Lot #, 

Expiration, and Analyte fields. 

NOTE: The Dilution list and Apply Dilution button only appear if a quantitative analysis 

has been selected. 
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Assay Control 

Information 

Lists the selected control reagents. Existing control lot information can be applied or 

new information can be typed manually. 

Apply Ctrl Lot - Applies the control lot. 

Show Value - Expected, Low, and High set the expected, lowest, or highest 

acceptable con- centration of the analyte in the sample. 

Apply Values - Applies a value down or across the list of analytes. 

Dilution 

Contains the following dilution options: 

• 1:2 - Halves the standard from each previous iteration. 

• 1:10 (Log) - Computes a value of one-tenth of the standard from each previous 

iteration. 

• 1/2 Log - Creates a 1:3.16 dilution, or half of each 1:10 (Log) from each previous 

iteration. 

• As an alternative, you can type a number (must be a whole number) for your own 

dilution factor. 

Apply Dilution Applies the dilution selected in the Dilution list. 

Assay Control 

Information 

Lists the selected control reagents. 

Apply Ctrl Lot - Applies a control lot. 

Show Value - Expected, Low, and High set the expected, lowest, or highest 

acceptable con- centration of the analyte in the sample. 

Apply Values - Applies a value down or across the list of analytes. 
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Maintenance Page 

Use the Maintenance page to maintain and calibrate your system. 

Auto Maint (Auto Maintenance) Tab 

Use the Auto Maint tab to initialize, verify, and maintain the instrument. 

Figure 32: Auto Maint Tab 

 

Table 31. Auto Maint Tab Screen Elements 

Automated Maintenance 

Options 

Provides buttons for commonly used maintenance routines for the machine. 

• Calibration/Verification 

• Performance Verification 

• Fluidics Prep 

• System Shutdown 

Reagents 
• Calibration Kit 

• Performance Verification Kit 

Report 
The Reports tab displays with the Performance Verification Report chosen 

in the Report: list. 
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Import Kit 
Displays the Calibration and/or Performance Verification kits to choose to 

import. 

Run Initiates the chosen run. 

Lot Management Tab 

Use the Lot Management tab to manage calibration and verification kits. 

Figure 33: Lot Management Tab 

 

Table 32. Lot Management Tab Screen Elements 

Active 

Reagents 

Changes calibration or performance verification kits, lot numbers and expiration dates, or 

deletes a kit. 

Calibration Kit - Choose a calibration kit from this list. 

Performance Verification Kit - Choose a performance verification kit from this list. 

Delete Kit - Deletes the chosen calibration or performance verification kit (s). 



 

132 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Active Lot Number - Choose an active lot number for the chosen reagent from this list. 

Active Reagents table - Displays information about the selected reagent. It allows you to 

choose whether the lot is CAL, VER, Fluidics 1, or Fluidics 2. That choice is displayed in 

the Lot Details section. The choice changes what columns appear in the table in the Lot 

Details section. 

Lot Details 

Displays lot information for the lot chosen in the Active Reagents section. 

Lot Type - Displays the lot type selected. 

Lot # - Enter the lot number after clicking Add New. 

Expiration - Edit the expiration date after clicking Add New. 

Lot Details table - Enter target MFI values for the type of lot you chose in the Active 

Reagents section. If your choice was CAL, enter targets for CL1, CL2, and RP1. If it was 

VER, enter targets for each channel for each reagent. If it was Fluidics 1 or 2, you cannot 

enter any targets. 

Drive Fluid 

Provides information about the drive fluid. 

Current Lot # - Displays the lot number. 

Expiration - Displays the expiration date. 

Edit - Allows you to add or change the current lot # and expiration. 

Import Kit Opens the Import Calibration or Performance Kit dialog box to import a kit. 

Import Opens the Import Calibrator or Verification Lot dialog box to import a lot. 

Export 

Opens the Export Calibrator or Verification Lot dialog box. Select a name and location 

to save the calibrator or verification lot and click Save. You must have a lot chosen in 

order to Export. 

Add New 

Adds a new lot. Add information in the Lot Details section on the right side of the window. 

Enter a Lot #, Expiration, and target in the appropriate boxes and fields. Click Save to 

save the lot, or click Cancel to cancel the entry. 

Delete Deletes a lot selected in the Active Reagents list. 
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Commands and Routines (Cmds & Routines) Tab 

Use the Cmds & Routines tab to create a routine or to edit, delete, or run a selected routine or command and run 

one or more maintenance commands with or without saving them as a routine. 

 

MAGPIX® Drive Fluid and the solution in which microspheres are stored contain ProClin®, 

which may cause an allergic reaction. Use personal protective equipment (PPE), including 

gloves and safety glasses. 

MAGPIX Drive Fluid PLUS contains, and other laboratory reagents can contain, sodium azide 

as a preservative. Sodium azide may react with lead and copper plumbing to form highly 

explosive metal azides. Refer to local guidelines and regulations for proper disposal of 

unused and used MAGPIX Drive Fluid PLUS, as well as other laboratory reagents containing 

this preservative. 

Figure 34: Cmds & Routines Tab 

 

Table 33. Cmds & Routines Tab Screen Elements 

Plate Name 
The name assigned to the plate during sample probe height adjustment. Choose the correct 

plate from the list. 

 

When using multiple plates, use them in the proper order. Failure to do so can result in 

inaccurate data and test results. 
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Routine 

Name 

This list of pre-set routines and commands can be used for system maintenance. Some of 

these commands are also available on the Auto Maint tab. You can also create custom 

routines which appear in the Routine Name drop-down menu after you save the routine. 

Commands 

Commands you can add to routines. 

Wash - Sends distilled water through the fluidic lines in the system. It pulls the fluid from a 

well or from the reservoir and runs it completely through the system to the waste receptacle. 

Alcohol Flush - Removes air bubbles from the sample tubing and the cuvette using 70% 

isopropanol or 70% ethanol. The alcohol flush takes about 5 minutes. 

Sanitize - Uses the off-plate reagent area, because only the reservoir can accommodate the 

amount of fluid necessary to sanitize the instrument. The sanitize command performs a 

similar function as the alcohol flush command, but uses a 0.6% sodium hypochlorite solution 

with no additives to decontaminate sample lines and the cuvette after biohazard contact. 

Sanitize as part of your daily shutdown routine after bio- hazard contact. 

NOTE: The xPONENT® for MAGPIX® software may refer to a 0.6% sodium hypochlorite 

solution with no additives as ‘10% to 20% household bleach’. 

Clean - Aspirates a cleaning reagent such as 0.6% sodium hypochlorite solution with no 

additives or sodium hydroxide. 

NOTE: The xPONENT® for MAGPIX® software may refer to a 0.6% sodium hypochlorite 

solution with no additives as ‘10% to 20% household bleach’. 

Soak - Prevents salt crystals from forming in the probe due to air exposure. Soaking the 

probe replaces drive fluid in the probe with water. You should perform the soak function at 

the end of each day. The system uses at least 250 µL of distilled water. 

Rinse - Performs a rinse. 

Prime - Removes air bubbles from the system's fluidic pathways by drawing drive fluid from 

the drive fluid bottle. You do not need to supply solution in a plate. 

VER - Performs a verification. 

Fluidics - Runs fluidics. 

Clear Clears the highlighted command in the Command Sequence list. 

Clear All Clears all commands in the Command Sequence list. 

Different buttons appear at the bottom right of the window, depending on your selections in the window. 

Command 

Sequence 

Lists the routines in order in the Command Sequence list. The list includes the name of each 

command, location, reagent status, and any additional information. 
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Self Test - Performs a self-diagnostic to see if the system and all operations are functioning 

correctly. 

NOTE: You should perform a Self Test as part of your scheduled weekly maintenance. 

Report - Opens the Reports tab with Calibration and Verification Reports selected in the 

Report drop-down menu. Click Generate to view the selected report. 

Import - Imports the routine file. Choose a file and click Open. 

Cancel - Cancels changes made to the default location of one of the commands in the 

Command Sequence. Cancel only displays if changes have been made to the command 

sequence. 

Probe and Heater Tab 

Use the Probe & Heater tab to adjust the probe height and plate heater settings. 

Figure 35: Probe & Heater Tab 

 

Table 34. Probe & Heater Tab Screen Elements 

Plate Name Enter a name for a plate for future use, or choose an existing plate from the list. 

Plate Images 

Assigns a particular well to use for probe height adjustment in the main plate, reservoir, 

and strip wells. Selecting a well displays a green pin to denote its use for the height 

adjustment. 
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Current Height 
Used to fine tune the probe height after an auto-adjust. Displays the current height of the 

probe, and the arrows below allow for adjustments up or down. 

Auto Adjust 

Height 

Automatically adjusts the probe height using the specified location(s) in the main plate, 

reservoir, and strip wells. 

Luminex recommends that you calibrate the probe height using well D6. 

Move Probe 

Down 
Moves the probe down in the specified well(s). 

Plate Location 

pin 

A green pin that shows the well location used to auto adjust the probe height for the main 

plate, reservoir, and/or strip wells. The default (and recommended) location for the main 

plate is well D6. 

The main plate depicts a 96-well plate. 

Strip Wells depicts the strip well added to the off-plate reagent area when extra wells are 

required. A strip well is equivalent to one column of a plate, and, like a plate, its wells can 

be flat-bottomed, v-bottomed, etc. 

Reservoir depicts the reservoir added to the off-plate reagent area when procedures 

require larger amounts of a reagent, such as alcohol or distilled water. 

Plate Heater 

Enables and disables the Plate Heater by clicking ON or OFF. Also used to set the 

temperature of the plate to the number typed in the Set Temperature field. Up and down 

arrows allow half- degree increments. Click Apply to apply the new temperature settings. 

Current and Target temperatures display at the bottom of this section. The temperature 

range is 35°C to 60°C. 

 

The plate heater can become hot enough to cause injury. Use caution when handling 

after heating. 

Save Plate 
Appears when you have typed a new plate name in the Plate Name list, and is used to 

save the current plate. A warning message displays. 

NOTE: If you save a plate without performing an auto adjust, the plate name is saved, but the probe height 

adjustment is not. If you do this, you cannot use the plate with this instrument. If your purpose is to save this plate 

to use it when you create a protocol to export and, click Save. Otherwise, click Cancel and perform an auto 

adjust. 
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System Info Tab 

Use the System Info tab to view information and diagnostics about the Luminex® instrument. This tab contains the 

following information: 

 

Software 

Version 

Operating System 

Licensing 

Instrument Type 

Serial Number 

Firmware Version 

Calibration/Verification Status 

Delta Calibration 

Temp System Temperature 

Last Calibration 

Last Verification 

Last Fluidics Test 

Drive Fluid 

Waste Fluid 

Table 35. System Info Tab Screen Elements 

Items in the list relating to calibration and verification have one of the following states: 

Passed Indicates that the process completed successfully. 

Failed Indicates that the process was not completed successfully. Failed items appear in red. 

Not Current 
Indicates that verifiers are not current. Verifiers are not current if you have not calibrated 

the system since the last time you ran the verifiers. 

Not Yet Run Indicates that this process has not yet been run on the machine. 

Copy 
Copies the system information to the Windows® clipboard. You can then paste it into a 

text editor such as Notepad. 

Save 
Opens the Save As dialog box to specify a file name and location to save the system 

information file. 
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System Status Tab 

Use the System Status tab to view, print, and save system status log information. 

Table 36. System Status Tab Screen Elements 

Search By Log Type Filters the type of log information. 

Search By Log Date Enables using a date range to display a log of system activities. 

System Log table Displays a list of information about each system process. 

Export 

Enter a name and choose a location for the system log to export to. Select 

Overwrite to overwrite a pre-existing file. This button exports the file in .CSV 

format. 

Advanced 
Displays the following added information in the system log - Log Type, User ID, 

and Error Level. 

Schedule Tab 

Use the Schedule tab to view reminders for scheduled maintenance due to be performed on the instrument. 

Table 37. Schedule Tab Screen Elements 

Reminders 

Subject - The scheduled maintenance. 

Reminder - A description of the scheduled maintenance. 

Next Alert Date - The date xPONENT® alerts you about the scheduled maintenance. 

Alert Time - The time xPONENT alerts you about the scheduled maintenance. 

Notes - Any additional information you want to know about the scheduled maintenance. 

Support Utility Tab 

Use the Support Utility tab to create a support file that you can send to Luminex Technical Support. To include 

batch information in the support file, use the Include Batch Information button and the Select Batch table. 

Table 38. Support Utility Tab Screen Elements 

Include Batch 

Information 

Select this check box to include batch information with the support file. It activates the 

Select Batch table. 
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Select Batch 
This table includes columns for the following information about a batch - Name, Protocol, 

Protocol Version, Date, Status. 

Support Launches the Support Utility dialog box. 

 

 

Admin Page 

You must have the appropriate licenses to view some of the features on the Admin page. 

System Setup Tab 

Use the System Setup tab to configure system settings such as application settings, LIS settings, maintenance 

options, and external analysis program settings. These settings change some of the basic ways that xPONENT® 

works, allowing customization of many of the basic functions. Select the options you want to enable and click 

Save. 

Table 39. System Setup Tab Screen Elements 

Application Settings 

Enable Virtual Keyboard - Enables the touch screen virtual keyboard. 

Allow the application to be minimized - Enables minimization of the xPONENT 

software so that the computer’s desktop can be accessed. If this check box is clear, 

the application’s minimize button does not function. 

Ignore user permission when attempting to exit software - Enables the user to 

exit the xPONENT software, regardless if permission has been granted in the User 

Setup tab. 

Add header when exporting data from grids - Adds a header row when exporting 

the data. 

LIS Settings 

This setting is only for those using xPONENT with a Laboratory Information System 

(LIS). 

Connect to LIS - Enables connection to the LIS. 

Browse - Opens the Browse For Folder dialog box. Choose a location for the 

system to watch for incoming orders. This button does not work if LIS is not 

enabled. 

External Analysis 

Program Settings 

This option is for those using a program other than xPONENT to analyze collected 

data. 
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Installed Analysis Programs - Lists the analysis programs currently installed. 

Add New - Opens the New External Analysis Program dialog box. 

Browse - Opens another dialog box to select the file location for the third-party 

analysis program. The selected location appears in the Path window, and the name 

displays in the Name field. 

Command Line Parameters - To keep the default command line settings, leave 

Command Line Parameters blank. Otherwise, type the command line parameter 

for which parameters you want xPONENT to use with the external analysis 

program. If the information is supplied with the external analysis program 

documentation, use that information. Otherwise, you can type the following 

parameters built into xPONENT, in any order: 

#c - Output.csv, full file path, #p - Protocol name, #b - Batch name, #u - Logged in 

user name 

Set Default - Sets the chosen analysis program as the default analysis program for 

xPONENT. 

Remove Removes the selected program from the Installed Analysis Programs list. 

Edit 
Opens the New External Analysis Program dialog box where you can edit the 

settings for the selected program. 

Disable Automatic 

launching of 

External Analysis 

when batches 

complete for all 

protocols 

Disables the automatic launch of the third-party analysis program after batch 

acquisition. 

Arrange Main 

Navigation Pages 

These options enable you to customize the order in which the Main Navigation 

buttons (pages) display. 

Main Navigation Arrows - Moves the selected header’s order of appearance at the 

top of the window. 

Default - Restores the software to the default page header arrangement. 

Maintenance 

Options 

System Initialization Procedure - Displays the available selections to use as the 

default system initialization procedure. 

Calibration expiration days - Choose the number of days in which the calibration 

of the system will expire. 
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Add an External Analysis Program 

1. If the program is on an external media such as a CD or flash drive, insert the media. 

2. Navigate to the Admin page > System Setup tab. 

3. Click Add New to open the New External Analysis Program dialog box. 

4. Enter a name for the external analysis program. 

5. Click Browse to navigate to the .exe file for that program. Double-click the file name. 

6. Enter the command line parameter for the parameters you want xPONENT® to use with the external 

analysis program. If the information is supplied with the external analysis program documentation, use that 

information. Otherwise, you can type the following parameters built into xPONENT, in any order: 

• #c - Output.csv, full file path 

•  #p - Protocol name 

•  #b - Batch name 

•  #u - Logged in user name 

NOTE: To keep the default command line settings, leave Command Line Parameters blank. 

Edit an Analysis Program 

1. Navigate to the Admin page > System Setup tab. 

2. In the Installed Analysis Programs list, click the program you want to edit. 

3. Click Edit. The Edit External Analysis Program dialog box displays. 

4. Edit the Name, Path, or Command Line Parameters, or make this the default analysis program if there are 

two or more programs installed. The default analysis program name displays in bold text. 

Remove an Analysis Program 

1. Navigate to the Admin page > System Setup tab. 

2. In the Installed Analysis Programs list, select the program you want to uninstall. 

3. Click Remove. 

4. To prevent the external analysis program from starting automatically, select Disable automatic launching 

of External Analysis when batches complete for all protocols. 

Group Setup Tab 

This tab is accessible only in the Security or 21 CFR Part 11 packages. Use this tab to assign permissions to 

different groups of users. Additionally, if you have the 21 CFR Part 11 package, you can require an electronic 

signature in order to perform selected tasks. 

NOTE: The 21 CFR Part 11 package also provides full access to the Secure Package functionality. 

Users are assigned to groups and permissions are granted to each group. Do not assign permissions directly to 

individual users. Use this tab to unlock accounts for users who have locked themselves out of the system. 

  



 

142 

MAGPIX® User Manual  
 

For Research Use Only. Not for use in diagnostic procedures. 

Table 40. Group Setup Tab Screen Elements 

Group Profile 

These user groups are predefined: 

• Administrator 

• Supervisor 

• Service 

• Technician2 

• Technician1 

• Reviewer 

The user belongs to the group to which you assign them. 

Group Features 

The Group Features list contains permission categories. When you select a 

category from the list, the Features section displays the individual tasks that 

are a part of that category. The following categories are available: 

• System Administration 

• Batch Management 

• Protocol Management 

• Lot and Std/Ctrl Kit management 

• Import and export data 

• Archiving 

Allowed check box Enables the selected group to perform that task. 

Signature Required check 

box 

Requires a digital signature whenever a user in the selected group performs 

that task. 

Clear Allowed and select Signature Required to require the electronic signature of another user whose 

account is configured to allow the action. When you do this, the current user cannot complete the action 

without this electronic signature. Activities performed with “Signature Required” are tracked in the System 

Log. 

 

Permissions Available by Group 

• System Administration 

• Manage Users (add, edit, or delete users) 

• Manage System Configuration 

• Perform Calibration and Verification 

• Manage Alerts 

• Manage scheduled maintenance 

• Change batch options and CSV options 

• Allow exit software 

• Batch run override system 

• Create, delete, activate Cal and Ver Lots and Kits 
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• Protocol Management 

• Create Protocol 

• Edit Protocol 

• Delete Protocol 

• Batch Management 

• Create Batch 

• Edit Batch 

• Delete Batch 

• Run Batch 

• Validate and Invalidate Results 

• Replay Batch/Recalculate Data 

• Approve Batch 

• Reanalyze Results 

• Save Batch after changing results 

• Change Formula 

• View Processed Batch Results 

• Export Processed Batch Results 

• Lot and Std/Ctrl Kit Management 

• Create Std/Ctrl Kit and Lots 

• Edit Std/Ctrl Kit and Lots 

• Delete Std/Ctrl Kit and Lots 

• Archiving 

• Backup/Restore 

• Archive 

• Import and Export Data 

• Export Batch, Protocol, Kit or Lot Files 

• Import Batch, Protocol, Kit or Lot Files 

When you perform an action that requires an electronic signature, the Electronic Signature dialog box displays. 

The user ID auto-populates. Enter your password and any comments. Click OK to complete the electronic 

signature, or Cancel to cancel the signature. 

Set Up Group Permissions 

1. Navigate to the Admin page > Group Setup tab. 

2. In the Group Profile drop-down menu, click the group profile you want to set up. 

3. In the Group Features drop-down menu, choose each group feature you want to set for the group profile 

you chose. 

4. In the Features section, select the Allowed check box next to the desired permission to enable the 

selected group to perform that task. If you are using the 21 CFR Part 11 package, enable the Signature 

Required check box next to the desired permission to require a digital signature whenever a user in the 

selected group performs that task. 

NOTE: These tasks are tracked in the System Log. 
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NOTE: Depending on the features you choose for the group, the list of permissions change. 

5. Click Save. 

6. In the Settings Saved dialog box, click OK. 

User Setup Tab 

Use the User Setup tab to create or edit a user account, remove a user from the system, or view a list of 

authorized users and their profile details. 

NOTE: You must have administrative privileges and be using the Secure version of xPONENT or the 21 CFR Part 

11 version to perform these tasks. 

Table 41. User Setup Screen Elements 

Create 

New User 
Opens the Create User Account window. 

Global 

User 

Settings 

Password Expiration - Enter a length of time in days. The default is 180 days. 

Unsuccessful Login Attempts - The default number of allowed unsuccessful logins is three 

attempts. 

Automatic Logoff (seconds) - How many seconds pass until an automatic logoff. Default is 

0. 

Minimum User ID Length - The default minimum User ID length is six characters. 

Minimum Password Length - The default minimum password length is six characters. 

Users 
Displays a list of all users. The list includes ID, Name, and Group Profile information, and 

indicates whether or not a user account is locked. 

Delete 

User 
Removes a selected user from the list. 

Edit User 
Opens the Edit User Account screen. This screen has the same options as the Create User 

Account screen. 

Create a New User Account 

1. Navigate to the Admin page > User Setup tab. 

2. Click Create New User. The Create User Account window displays. 

a. Enter the user ID in the User ID field. The user ID is not case-sensitive. 

NOTE: You can change the required number characters for a user ID on the User Setup tab. Once 

you create and delete a user ID, you cannot use that user ID again. 
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b. Enter the user's name in the User field. 

c. Select the Account Status check box to lock the account, or clear this check box to unlock the 

account. 

d. Enter a password for the user Password field, then re-enter it in the Reenter Password field. 

i. If you want the user to change the password on first login, select Change password after 

next login. The required length for passwords is set on the Group Setup tab. 

e. In the Group Profile drop-down menu, choose the role for the user your are creating. 

3. Click Save to return to User Setup. 

4. Click Cancel to return to User Setup without saving. 

Define Global User Settings 

The settings in the Global User Settings section affect all users in all user groups. You can retain the default 

settings or type your own values. 

To define Global User Settings, complete the following: 

1. Navigate to the Admin page > User Setup tab. 

2. In the Global User Settings section, type a length of time (in days) for the Password Expiration. 

3. Set the number of allowed Unsuccessful Login Attempts. 

4. Set how many seconds pass before an Automatic Logoff (seconds) is initiated. 

5. Enter the Minimum User ID Length. 

6. Enter a Minimum Password Length. 

7. Click Save. 

8. In the Settings Saved dialog box, click OK. 

Edit User Permissions 

1. Navigate to the Admin page > User Setup tab. 

2. In the Users section, choose the user ID, then click Edit User. 

3. In the Edit User Account window, edit the desired information. 

4. Click Save. 

Restore Account Status 

If users attempt to log in unsuccessfully more than the number of times allowed, they will be locked out. 

1. Navigate to the Admin page > User Setup tab. 

2. In the Users section, choose the user ID, and click Edit User. 

3. Clear the Account status: Locked check box. 

4. Click Save. 
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Batch Options Tab 

Use the Batch Options tab to set options for analysis and acquisition of batches. 

Table 42. Batch Options Tab Screen Elements 

Batch Options 

Allow running a batch if the instrument is not calibrated or verified. - Allows 

batches to run if the instrument is not calibrated. 

Settings to enable running/saving with expired agents, running with XY temperature 

out of range, and running a batch if the instrument is not calibrated or verified are 

managed at the system level. If one or more of these options is enabled, you cannot 

run batches while the condition exists. However, if you have the group permission 

Batch run override system, you can run a batch with the condition present. Without 

Batch run override system you are unable to override any or all of these conditions 

and therefore cannot run or save batches. 

Use weighting as default option for quantitative analysis. - Sets the weighting for 

quantitative analysis to default to ON for new protocols. 

Warn when saving/running a New Batch with New Protocol without saving the 

Protocol and/or Standard and Control information. - Opens a dialog box warning 

when saving or running a new batch with a new protocol when you have not saved 

the protocol and/or standard and control information. 

Batch Settings 

Analysis display decimal places - Enter the number of digits the system displays. 

The default number of digits is three. 

Calibration expiration days - Enter the desired number of days a system calibration 

remains active before expiring. The default number is seven. 

Minimum bead count for obtaining results - Enter any whole number from 0 to 

1000000. This is the minimum bead count that must be observed by the instrument 

for a particular analyte before this data is used in statistical calculations and is 

displayed on the graphs and results table. When set to a number greater than 0, the 

instrument does not display data for bead sets not generating events equal to or less 

than this value. Enter 0 to display all events. The default setting is 1. 

Allow batches to be run or saved without lot number, expiration or 

manufacturer - Allows saving lots without normal required information. 

Default Pre-Batch Routine - System maintenance routines like wash, flush, or clean 

can be programmed at different points in a batch to prevent clog formation and 

maintain peak system performance. Pre-batch routines, specifically, are 

recommended for challenging sample matrices like viscous material or material 

containing particulates in suspension because these matrices can clog the 

instrument. Choose the Pre Batch Routine to specify a particular routine to run before 

running a batch. 

NOTE: A Rinse command runs after all pre-batch routines. 
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Default Post-Batch Routine - A Luminex Post-Batch routine automatically runs at 

the end of each batch to clean the sample chamber and maintain peak system 

performance. This can- not be deleted or modified and runs by default. However, you 

can turn off this routine or use a different routine. Luminex recommends cleaning the 

system with 0.1N NaOH. 

Default Routines - System maintenance routines like wash, flush, or clean can be 

programmed at different points in a batch to prevent clog formation and maintain 

peak system performance. Pre-batch routines, specifically, are recommended for 

challenging sample matrices like viscous material or material containing particulates 

in suspension because these matrices can clog the instrument. Select this option to 

specify a particular routine to run before running a batch. 

Default Analysis Graph Axes - Either Log X Axis or Log Y Axis. 

Batch Thresholds 

Detection enabled - Select or clear for low bead count detection. 

Well Count - When this many consecutive wells acquire a bead count lower than the 

number specified in the Total Bead Count field, the low bead count action is taken. 

Total Bead Count - The number of beads that must be counted per well to not 

receive a warning message. 

Action - Select either Error (Stop), Warning (Pause), Warning (Log), or Run 

Routine. The selected action is taken when the number of wells in the Well Count 

field are run without reaching the number of beads in the Bead Count field. 

Alert Options Tab 

Use the Alert Options tab to set options for alerts about various system events. 

Set Up Notification Options 

To set notification options for various events: 

1. Navigate to the Admin page > Alert Options tab. 

2. Select Dialog if you want a dialog box to open for a specific event. 

3. Select Email if you want to send an email notification for a specific event. 

NOTE: Make sure the PC is connected to a network before trying to send an email. 

4. Select Sound if you want a sound to play for a specific event. 

5. If you choose to send an email notification for a specific event, and the email address is not already set up, 

click Setup Email to open the Setup Email dialog box. Turn email notifications on or off by selecting or 

clearing the Email Active check box. 

a. Contact your system administrator to determine the correct information for the Mail Server Host, 

From Email Address, From Email Password, and Mail Server Port fields, and if you need to 

select the Enable SSL (Secure Sockets Layer) check box. 

b. Enter email addresses in the Email Addresses (separated by commas) field that you want to 
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send alert notifications to. 

c. Click Test to send a test email to the addresses you have entered. 

6. Click OK to apply any changes. 

7. In the Save Settings dialog box, click OK. 

CSV Options Tab 

NOTE: You must have administrative privileges to perform this task if you are using the 21 CFR Part 11 or Secure 

pack- age. 

Use the CSV Options tab to define what the CSV (comma-separated values) file will contain and where it will be 

stored. 

Table 43. CSV Options Tab Screen Elements 

Automatically export results 

CSV file when batch is 

complete 

Automatically exports the results to a CSV file when the system finishes 

analyzing the batch. This allows running programs on exported data 

without having to manually start the export. 

Automatically export batch 

when batch is complete 
Exports batch information automatically when a batch has completed. 

Maximum number of data 

columns in CSV file 

Sets the number of individual values in each line of the comma-separated 

value output file. Each value is separated from the previous and following 

value by a comma. 

Use US regionalization 

format only 

Exports data only in US regionalization format. Use this option if your 

external analysis program requires a CSV output file with US delimiters. 

Include Advanced Statistics 
Exports advanced and additional statistics, for example, trimmed counts, 

in the CSV file. See the CSV file specification for details. 

CSV Export Folder and 

Automatically Exported 

Batch Folder 

Displays the path and location where the CSV file or automatically 

exported batch file will be exported. Click Browse to change the file export 

location. 

Automatically Export LXB 

files 

Displays the path and location where the LXB file will be exported. Click 

Browse to change the file export location. 

Automatically Export Run 

CSV files 

Displays the path and location where the Run CSV file will be exported. 

Click Browse to change the file export location. 

Automatically convert the 

raw run files to CSV format 

for each well in the batch 

Automatically converts raw run files to CSV format for each well in the 

batch. This option creates a CSV formatted file for the raw bead data of 

each well. 

Test Sort Order 
Defines a method to sort the test data. The options are By Analyte Name, 

By Region ID, or By Setup Order. 
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Archive Tab 

Use the Archive tab to archive all file types - batches, protocols, kits, lots, and LIS records. When you click the 

Launch Archive Utility button, the Archive Utility dialog box displays. 

NOTE: To back up or restore xPONENT® files, quit the application and select xPONENT ARCHIVE from the 

Windows® Start menu. 

Archive Utility Dialog Box 

Click the Launch Archive Utility button to open the Archive Utility dialog box. 

The Archive Utility can be used within xPONENT® to set up the frequency and types of files to back up. Statistics 

about disk space and archive space used, as well as the types of files to back up, appear on this page. 

The archive utility runs continuously. If automatic archives are scheduled, they occur whether xPONENT is 

running or not. When you want to backup or restore xPONENT, quit the application and run the Archive Utility 

from the Start menu. 

 

Schedule Overview Schedules archiving. 

First Occurrence Select the date and time for the first automatic archive. 

Frequency Establishes how frequently the system performs the archive process. 

Reminder Only 
Establishes whether you want a regular reminder from the system so that you can 

per- form archiving manually. 

To Be Archived Establishes which files are archived. 

Archive Folder 

Select the folder in which files are archived. If the output folder is on a network 

share and the share becomes unavailable, the system archives locally and sends 

you a note where the archived files are. 

Archive Events Lists all events related to archiving activity. 

System Displays how many files of each type are currently in xPONENT®. 

System Backup 
Backs up your system. It requires a log on and then instructs you to shutdown the 

xPONENT software and launch the Archive Utility from the Start menu. 

System Restore 
Restores your system. It requires a log on and then refers you to the Start menu 

to restore your system. 

Manual Archive 
Performs a manual archive process. It requires a log on and then opens the 

Manual Archive window. 
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Licensing Tab 

Contact Luminex Technical Support to obtain a license key for xPONENT® for MAGPIX® software. NOTE: You 

must restart the computer for the new license to take effect. 

Add a New License Key 

1. Navigate to the Admin page > Licensing tab. 

2. Click License (bottom right corner of window). 

3. Copy and paste the new key into the Your new License Code field. The License File field remains blank. 

4. Click OK. This closes xPONENT®, applies the license, and restarts xPONENT. 

5. Contact Luminex Technical Support if you have any difficulty saving or adding a new license key. 

Schedule Tab 

Use the Schedule tab to view reminders for scheduled maintenance due to be performed on the instrument. 

Table 44. Schedule Tab Screen Elements 

Reminders 

Subject - The scheduled maintenance. 

Reminder - A description of the scheduled maintenance. 

Next Alert Date - The date xPONENT® alerts you about the scheduled maintenance. 

Alert Time - The time xPONENT alerts you about the scheduled maintenance. 

Notes - Any additional information you want to know about the scheduled maintenance. 

Edit Maintenance Schedule Settings 

1. Navigate to the Admin page > Schedule tab. 

NOTE: The Schedule tab can also be accessed from the Maintenance page, but the settings cannot be 

edited from there. 

2. On the Schedule tab, use the drop-down menus to edit the Alert Time and Recurrence frequency for any 

scheduled activity. 

3. Enable or disable the reminders by selecting or clearing the Enabled check box. 

4. Click Save. 

5. In the Settings Saved dialog box, click OK. 
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Report Options Tab 

Use the Report Options tab to set how reports are displayed and printed. 

Customize How the Report Looks 

1. Navigate to the Admin page > Report Options tab. 

2. Enter a company name in the Company field, and any additional information in the Info field. 

3. Click Import Logo to open the Windows® Open dialog box and select the file you want to use for the logo 

at the top of reports. Click Open. 

NOTE: The logo file should be 920 x 125 pixels. If you want the logo to display to the right of your 

company name, include 120 pixels of white space to the left of the logo in the graphic file. If you do not 

include white space, the logo may display behind the company information. 

4. Click Clear Logo to return to the default logo. (Optional) 

5. Click Save. 

6. In the Settings Saved dialog box, click OK. 
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